
PanaboardPanaboard

Operating Instructions

Electronic Print Board
(Interactive Panaboard)

MODEL NO.  KX-BP800

Stand and wall-mounting kit are optional.

D To assemble this unit, please refer to the Installation Manual on pages 72 through 84.
D Before operating this unit, please read these instructions completely.

After reading them, keep them for future reference.
D Because of the nature of the print film, all the printed text will remain on the film.
D This product is designed for installation by a qualified servicing dealer.

Installation performed by non-authorized individuals could cause safety-related problems with
the operation of this equipment.

D To locate the closest authorized dealer in your area, please call 1-800-449-8988.

with Installation Manual
(for qualified service personnel)
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Thank you for purchasing the Panasonic Electronic Print Board.
For optimum performance and safety, please read these instructions carefully.

CMicrosoft®, Windows®, Windows NT® and NetMeeting® are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries.

Windows® is Microsoft® Windows® operating system.
Windows NT® is Microsoft® Windows NT® operating system.
NetMeeting® is Microsoft® NetMeeting® conferencing software.

CIBM® is a registered trademark of International Business Machines Corporation.
CPentium® is a registered trademark of Intel Corporation in the U.S. and other countries.
CAdobe®, Acrobat® are registered trademarks of Adobe Systems Incorporated.
CAll trademarks referred to in this manual are the property of their respective companies.

Things you should keep a record of

Attach your sales receipt here
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For your future reference

Date of purchase Serial number

Dealer’s name and address

Dealer's telephone number

Warning about saving data
When the system storage device or any of its optional storage device is adversely effected by operational errors,
static electricity, electrical noise, vibration, dust or when the power has been cut off due to malfunction, repair or
inadvertently, the memory contents may be lost or changed. Before operating the system, make a point of
reading the precautionary notes in the Operating Instructions and the help information, and observe them during
operation.
Please observe carefully the following precaution:
CC Make absolutely sure that all important data is saved by back-up or the original is saved.

The manufacturer hereby declares that it cannot be held accountable for any loss or change in any data stored on
floppy disks, hard disks, optical disks, or other memory devices.
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Accessories
CFilm cassette (Blue gear✕1, Green gears✕3).......1

CThermal transfer film [20m (65.6')] ...................1

CMarkers (Black, Red, Blue-Big) ..............Each 1

CEraser...............................................................1

CLetter papers.......................................20 sheets

CPen holder ........................................................2

CMarkers for interactive

(Black, Red, Blue, Green-Small) .......Each 1

CElectronic eraser ..............................................1

CEraser cloth (for Electronic eraser)...................2

CBatteries (LR03 “AAA”).....................................6

CPower cord .......................................................1

CInteractive cable (5m).......................................1

CSoftware CD-ROM ...........................................1

COperating Instructions ......................................1

CSoftware License Agreement ...........................1

CWall-mounting template....................................1

Warning Notices

THE SOCKET-OUTLET MUST BE NEAR THIS EQUIPMENT AND MUST BE EASILY ACCESSIBLE.

WARNING:
TO PREVENT FIRE OR SHOCK HAZARD, DO NOT
EXPOSE THIS PRODUCT TO RAIN OR ANY TYPE OF
MOISTURE.

CAUTION:
TO PREVENT RISK OF ELECTRIC SHOCK HAZARD, DO
NOT REMOVE THE COVER OF THIS PRODUCT, REFER
SERVICING TO QUALIFIED SERVICE PERSONNEL.

Federal Communications Commission Requirements

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required
to correct the interference at his own expense.

FCC Warning: To assure continued FCC compliance, the user must use only the provided power supply cord. Also, any
unauthorized changes or modifications to this equipment would void the user’s warranty.

The markers (Big) and the eraser are used for other than the interactive function.

The markers for interactive (Small) are used while inserted in the pen holder.

In this manual, the pen holder with a marker for interactive (Small) is called the Electronic Pen.
The Electronic Pen and the Electronic Eraser are used with the interactive function. 

Download from Www.Somanuals.com. All Manuals Search And Download.
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Features
The KX-BP800 is equipped with two interactive functions; Projector mode and Whiteboard mode, in addition to a
regular electronic print board that utilizes plain paper. It is possible to use this product as follows.

CElectronic print board
Functions

CAllows copying up to 9 copies per screen
CAllows printing in 2 level contrast (Normal/Dark)
CAllows printing of 2-screens at the time by compressing them into a single sheet of paper

CProjector mode (Interactive function)

Connect the Interactive Panaboard to a computer that is connected to a projector and use the projector to
project the image onto the Interactive Panaboard.
This is called the Projector mode.
In this mode, the following operations are possible:

COperating the computer using the Electronic Pen with its cap on as a mouse
CDrawing handwritten lines or erasing it using the Electronic Pen with its cap on in the projected image
CSaving the projected image to an image file and printing the projected image
CRecording the operations of drawing and erasing handwritten lines, playing back and editing the recorded

operations later

In Projector mode, the projected computer image on the screen of the Interactive Panaboard can be operated by
using the Electronic Pen as a mouse. You can execute the application and electronically write or erase notes.
The electronically handwritten or partially erased computer image can be stored into an image file. This will help
make your presentation more impressive to the attendants.

Download from Www.Somanuals.com. All Manuals Search And Download.
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Features

CWhiteboard mode (Interactive function)

By connecting the Interactive Panaboard to a computer, the information written on the Interactive Panaboard is
displayed on the computer in real-time.

This is called the Whiteboard mode.

In this mode, the following operations are possible:

CThe information written on the Interactive Panaboard using the Electronic Pen with its cap off will be
displayed on the computer screen at the same time.

CThe information erased using the Electronic Eraser will be erased in the computer as well.

CYou can save drawings and notes into a file which can later be printed.

CAllows the user to record the information being written or erased in a file that can be played back as a movie
and it can be edited if needed.

CPC Interface (Option)
When the optional PC Interface Kit (KX-BP095) is used, you can scan monochrome images from the KX-BP800
into a computer running Microsoft® Windows® or Windows NT® and print documents on the computer to the
printer of the KX-BP800.

For the operation using the PC Interface Kit, please refer to the Operating Instructions of the PC Interface Kit
(KX-BP095).

Download from Www.Somanuals.com. All Manuals Search And Download.
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Table of Contents

Precautions ...........................................................................8

Part Names and Functions.................................................12
CThe control panel ............................................................................13

Installing Thermal Transfer Film .......................................14

Loading Copy Paper...........................................................16

Making Copies ....................................................................18
CCopy types and procedures ............................................................19

Replacing Thermal Transfer Film ......................................20

Paper Jams..........................................................................21

Before Using the Interactive Function..............................24
CSetting the Electronic Pen...............................................................24
CSetting the Electronic Eraser...........................................................25
CReplacing the eraser cloth ..............................................................25
CSystem requirements ......................................................................26
CConnecting to the PC......................................................................26
CInstalling the software .....................................................................27

BUninstalling the software ................................................................................27

Using the Interactive Panaboard Software.......................29
CStart up the Interactive Panaboard Software ..................................29
CPop-up menu configuration of 

the Interactive Panaboard Software .........................30
CSwitching the mode.........................................................................30
CSettings of the Interactive Panaboard Software..............................30  
CReference the help..........................................................................31
CDisplay the information about 

the Interactive Panaboard Software .........................31
CExiting the Interactive Panaboard Software....................................31

Projector Mode....................................................................32
CPrecautions when using a projector ................................................32
CBasic operation flow in Projector mode...........................................33  
CAbout Desktop Drawing Tool...........................................................36
CDesktop Drawing Tool operation .....................................................37
CAbout View window.........................................................................42
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Daily Care and Maintenance ..............................................65

Troubleshooting..................................................................67
CMeanings of various displays ..........................................................69

Specifications .....................................................................70
CConsumable and accessories .........................................................71

Installation Manual .............................................................72

Whiteboard Mode................................................................43
CBasic operation flow in Whiteboard mode.......................................43  
CAbout Whiteboard window ..............................................................45

View Window or Whiteboard Window Operation.............46
CDifferences between the View window and 

the Whiteboard window ..................46
CMenu configuration..........................................................................46
CTool bars..........................................................................................48
CCreate an IPB document (Whiteboard window only) ......................49
COpen an IPB document...................................................................49
CSave the IPB document ..................................................................50
CSave the IPB document in another file format.................................50
CChange display method ..................................................................53
CSwitch a page of the IPB document ................................................54
CEdit a page of the IPB document ....................................................54
CPlayback the IPB document ............................................................57
CPrint the IPB document ...................................................................58
CSettings ...........................................................................................58

Remote Conferencing Using Microsoft® NetMeeting® ....63
CAbout NetMeeting® .........................................................................63
CExample of using NetMeeting® .......................................................63

The IPB document is a Interactive Panaboard format file (extension ".ipb").
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Precautions
Never remove the cover, or take apart or modify the
product. This will void the warranty.

Do not position the electronic print board in a location
where it is not stable.

Do not put drinks or other liquids on the tray. After installing or moving the electronic print board,
lock the casters and set the fall-prevention extension
legs.

Do not use the electronic print board in an excessively
humid or dusty location.

If the electronic print board is not going to be used for
an extended period of time (e.g., during extended
holidays), turn off the power and remove the plug from
the wall outlet. 

Locking the casters
(Push this side)
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CMake thick and dark lines inside the copying 
area. Note that any writing inside the 
shaded area on the right figure cannot 
be copied.

CUse a commercially available white board cleaner for hard-to-erase stains.
(SANFORD® EXPO® white board cleaner etc.)

CDo not erase with an overly dirty eraser. (See page 65.)

CDo not allow writing to remain on the screen for an extended period of time as it
will become harder to erase.

CPeriodically wipe the screen film gently with a water-dampened cloth that has
been thoroughly wrung. (See page 65.)

CDo not touch the screen, write with markers, or erase while the screen is moving
as this may result in damage to the unit.

Precautions

Installation CDo not install the unit where it may be exposed to direct sunlight, near heating
equipment, or near air-conditioning vents as this may cause stretching and/or
discoloration of the screen.

CDo not install the unit in locations having a temperature of 10°C (50°F) or lower or
where the temperature may change suddenly as this may disable the unit’s ability
to make copies.

Screen film

Copying area

25mm (1")

25mm (1")

35mm
(13/8")

35mm
(13/8")

Markers,
Erasers and
Thermal
transfer film

CUse only the included or designated markers, erasers and thermal transfer film.
(See page 71.)
Use of accessories other than those included or designated (such as oil-based
markers) may damage the screen or result in hard-to-erase markings.

CCopy quality increases with the thickness of the drawn line. To ensure quality
copies, please use the markers (Big).

CThe markers for interactive (Small) draw thin lines. The quality of the copies may
be reduced when these markers are used.

CDo not store the thermal transfer film in a location subject to extreme changes in
temperature (such as near air conditioning or heating equipment) as this may
cause condensation on the thermal transfer film and result in poor print quality
and/or paper jams.

CStore markers horizontally as vertical storage may stop the ink from coming out.

CThe length of one roll of designated thermal transfer film (Replacement film : KX-
BP081 or KX-BP082) is approximately 100 meters (328.1'). One roll of thermal
transfer film can make approximately 300 sheets of copies.
Note that the total number of copies may differ depending on the operating
conditions.
Also note that the length of the thermal transfer film supplied with the unit is
shorter than the replacement film roll and is only approximately 20 meters (65.6').

SANFORD® and EXPO® are registered trademarks of Sanford corporation.

Download from Www.Somanuals.com. All Manuals Search And Download.
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Precautions

Power cord

and Interactive

cable

CBefore moving the unit, disconnect the power cord from the electrical power
socket and AC inlet, and disconnect the interactive cable from the interactive
connector and a PC. Then coil them for transportation. Failure to do these cause
the cord and cable to be damaged if they are stepped on or if they catch on
something while the unit is being moved.

Replacing the
Thermal
transfer film

CDispose of the used thermal transfer film in a trash receptacle for burnable trash.

CA negative of the copied image will remain on the thermal transfer film. 
(To protect the security of your information, we recommend cutting up used
thermal transfer film with scissors or shredder before disposing of it.)

Electronic Pen
and 
Electronic
Eraser

CDo not cover the transmitter with your hand while using an interactive function as
this may cause the position of the Electronic Pen or the Electronic Eraser not to
be normally detected.

Transmitter

CPress down firmly with the point of the Electronic Pen or the eraser cloth of the
Electronic Eraser on the screen film until you hear a buzzing sound, and then
move it slowly.
However, do not press down the point of the Electronic Pen too much strongly as
this may make a dent in the screen back panel.

CDo not use two or more the Electronic Pens or the Electronic Eraser at the same
time as this may cause the position of the Electronic Pen or the Electronic Eraser
not to be normally detected.

CFor precise positioning, keep the Electronic Pen and Electronic Eraser
perpendicularly to the screen during use.

CSince ultrasonic is used to detect the position of the Electronic Pen and Electronic
Eraser when they are being used, you may hear a buzzing sound, but this is not
harmful to the human body or peripheral hardware. 
It will also not result in an electric shock.

NG OK
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Battery

Projector

If batteries are used improperly, batteries may leak, causing corrosion of the
product, or they may burst. To prevent this, always follow the precautions given
below.
CAlways remove batteries from the Electronic Pen and Electronic Eraser if they are

not to be used for an extended period of time.
CUse the same type of batteries. Do not mix different types.
CDo not mix old and new batteries.
CAlways insert batteries with their polarity properly oriented as indicated on the

Electronic Pen or Electronic Eraser.
CIf the Electronic Pen or Electronic Eraser ceases to function because batteries

have run out, remove them immediately and dispose of them according to local
regulations.
Leaving drained batteries in the Electronic Pen or Electronic Eraser may result in
leakage.

CDo not disassemble batteries or place them in a fire.
CDo not short batteries.
CAlkaline batteries cannot be recharged. Never attempt to recharge alkaline

batteries.

CLight from the projector may enter the eye when using a projector to project
images for the purpose of making presentations and so on. Be very careful as
direct projector light may hurt the eyes.

Download from Www.Somanuals.com. All Manuals Search And Download.
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Part Names and Functions
Electronic Pen/Electronic
Eraser Position Receiver

Screen Film

AC Inlet

Tray

Interactive Connector

Power Cord

Printer Open Lever
Push down this lever to open
the printer door.

Output Port
Outputs copy paper that 
has been copied. Can hold 
up to 20 sheets.

Paper Cover
Open this cover when loading
copy paper.

Printer Door
Open the printer door when loading
transfer film or when removing
paper jams.
(See pages 14, 20 and 21.)

ON

OFF

Control Panel

Electronic Pen (See page 24) Electronic Eraser (See page 25)

1KX-BP800Panasonic 2

Contrast/Remaining Film 
Indicator

Contrast Key

2-Screen Copy Key

Multi-Copy/Error Indicator

Advance Key

Copy Key

Multi-Copy/Stop Key

When using the projector mode to operate the
computer screen on the print board screen and
operating the pen while holding down the pen
button achieves the same function as pressing
the right mouse button.

Power Switch

Pen Button*

Pen Holder Lever

Eraser Cover

Eraser Cloth

Electronic Pen/Electronic
Eraser Position Receiver

Download from Www.Somanuals.com. All Manuals Search And Download.
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Part Names and Functions

■ The control panel

Name Panel Description

Contrast/
Remaining
Film
Indicator

Contrast
Key

This lamp indicator notifies the user when the time to replace the thermal
transfer film is approaching (estimated) and of the printing contrast used
during copying.
Indicator off : Normal printing contrast.
Indicator on : Darker than normal printing contrast.
Indicator flashing : Almost time to replace the thermal transfer film.

(Note that only about 15 more sheets may be copied when
this indicator starts flashing.)
Replacement film (KX-BP081 or KX-BP082) is separately
available from the dealer where you purchased your unit.

The flashing indicator will go out after the power is turned off and the printer
has been opened and closed. (When copying is performed, this indicator will
begin flashing again.)

Each time this key is pressed, the unit will alternate between normal and
dark contrast modes (Normal/Dark).

2-Screen
Copy Key

This key causes the front and back of the screen to be copied on a single
sheet of paper.

Copy Key This key prints a copy of the screen.

Advance
Key

This key advances the screen from right to left.

Multi-
Copy/
Error
Indicator

This indicator displays the number of copies to be made. The display
changes each time the multi-copy/stop key is pressed.
Example : 1→ 2 → … → 9 → 1 → …
When an error occurs, a flashing symbol will appear in this display to indicate the error
status. (See page 69.)

Multi-
Copy/
Stop Key

When making multiple copies, press this key until the desired number of
copies is displayed on the multi-copy/error indicator. This key can also be
pressed while multiple copies are being made to stop the copying
process. The display indication changes while multiple copies are being
made as shown below. After reaching 0, the display will reset to 1.
Example: 5 → 4 → 3 → 2 → 1 → 0 → 1 (countdown display during copying)

1 2
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Installing Thermal Transfer Film
Load the thermal transfer film into the film cassette and install in the printer.

Printer Open 
Lever

Printer Door

Blue Gear

Blue Gear

Gear Tabs Grooves
(Blue)

Green Gear

Tabs
Grooves

Green Gear

Green Gears

Thermal
Transfer Film

1 Set the power switch to on ( | ).

C" " will flash on the multi-copy/error indicator
when the thermal transfer film has run out.

2 Push down the printer open lever and open the
printer door.

3 Insert the four gears into the new thermal
transfer film.

CSecurely align the gear tabs with the grooves in
the thermal transfer film and insert them as far
as they will go.

CThere is a blue gear and three green gears
which need to be attached as shown in the
figure on the right.

Note

Power Switch
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Installing Thermal Transfer Film
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Thermal
Transfer Film

Load thermal transfer
film in this derection

Film Cassette

Blue Label

Blue Gear

4 Load the thermal transfer film into the film
cassette.

CLoad the thermal transfer film into the film
cassette so that the blue gear inserted in the
thermal transfer film is located on the blue label
side of the film cassette. Push in the direction
of the arrow until you hear all four gear shafts
click in place.

Slack Prohibited

Label

Thermal 
Transfer Film5 If the thermal transfer film is slack, take up the

slack by winding the gears on the label side of
the cassette in the direction of the arrows.

CThe multi-copy/error indicator may flash 
" " if the thermal transfer film is slack. 
In addition, the thermal transfer film may
wrinkle, and blank (unprinted) spots or black
streaks may appear on the copy paper.

Blue Label

Grooves

Grooves

6 Install the film cassette.

CInsert the film cassette into the printer so that
the blue gear on the cassette aligns with the
blue label on the printer and then insert the
gear shafts on both sides of the cassette into
the grooves inside the printer.

CIf the film is slack after loading the film
cassette, take up the slack in the same manner
described in step 5 while the cassette remains
loaded.

Printer Door

7 Close the printer door.
CSecurely close the printer door by using both

hands until a click is heard.
CThe " " flashing on the multi-copy/error

indicator will go out.

CIf the flashing " " does not go out even
though the printer door has been closed, this
indicates that the film cassette has not been
installed properly or that there is slack in the
thermal transfer film. Check the condition of the
film cassette and for slack in the thermal
transfer film.

Note

Download from Www.Somanuals.com. All Manuals Search And Download.



16

Loading Copy Paper
It is possible to load up to 80 sheets of Letter size copy paper [assuming a paper weight of 80g/m2 (21 lbs)].
Note that only Letter paper may be used.
When the unit is first used or when " " flashes on the multi-copy/error indicator to indicate that the unit is out of
paper, load copy paper as described below.

Notes on Loading Copy Paper

Follow the guidelines below to ensure smooth and accurate printing by the unit.

COnly use Letter size copying paper having a weight of 60 to 90g/m2 (16 to 24 lbs) as the copy paper for
this unit.

CDo not simultaneously load paper of varying type and thickness as this may result in paper jams.

CBefore adding copy paper, be sure to remove all copy paper remaining inside the unit's paper cover.
(Note : That copy paper will slightly resist being removed, but may be pulled out without problems.)
After removing the copy paper, stack the removed paper together with the new paper, fan it thoroughly,
square it and reload.

DO NOT USE THE FOLLOWING TYPES OF PAPER

CExtremely smooth or glossy paper

CCoated paper

CThermal paper

CPaper that is printed on one side

CWrinkled paper, creased paper, etc.

ON

OFF

1 Set the power switch to on ( | ).

C" " will flash on the multi-copy/error indicator

when copy paper has run out.

CBe absolutely sure to check that the power is
on when loading copy paper as it will not load
properly otherwise.

Note

Power Switch

Download from Www.Somanuals.com. All Manuals Search And Download.



17

Loading Copy Paper
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Paper Cover

Magnets

2 Pull the paper cover forward as shown in the
right figure. 

CThe magnets are used as fasteners to hold the
paper cover closed.

Maximum Paper Limit

Guide

3 To prevent paper jams such as those caused
by multiple sheets feeding, once fan the paper
thoroughly, square it, align it with the guide
inside, and insert as far as it will go. 

COnly use Letter size copying paper having a
weight of 60 to 90g/m2 (16 to 24 lbs) as the copy
paper for this unit.

CDo not stack more copy paper in the unit than
the maximum paper limit indicated by the guide
(see figure to the right) as this may result in
paper jams. [The unit can hold about 80 sheets
of paper having a weight of 80g/m2 (21 lbs).]

Note

Paper Cover

4 Close the paper cover.

Note
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Making Copies
This section describes how to copy text and illustrations drawn on the screen.

ON

OFF

1 Set the power switch to on ( | ).
C"1" will light on the multi-copy/error indicator to

indicate that the unit is ready to copy.

1 2

Output Paper

Copy Key

KX-BP800Panasonic

2 Press the copy key .

CText and illustrations on the screen will be
copied and copies emerge from the output port.

CThe output port can hold up to 20 sheets of
copy paper. (Note that exceeding the output
port's capacity may result in paper jams.)

CFor details on making multiple copies, 
2-screen copies and so on, see page 19.

CDo not use paper that has been copied on one
side by this printer as copy paper in this unit or
in any other copiers or printers as this may
result in dirty rollers, degradation of printing
quality, paper jams, and streaks and smudges
on output paper.

CCopy quality increases with the thickness of
the drawn line. To ensure quality copies,
please use the markers (Big).

CThe markers for interactive (Small) draw thin
lines. The quality of the copies may be reduced
when these markers are used.

Note

Power Switch
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Making Copies
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Copying the front
of the screen Press .

■ Copy types and procedures

Copy Type Procedure

Copying the back
of the screen

Press to move the screen to be copied to the front.

Press .

Making multiple
copies (up to 9)

Select the number of copies (1 to 9) by pressing as necessary.

Press .

CPress to stop copying in mid-operation.

Making 2-screen
copies
CCCopying the front and

back of the screen on a
single sheet of paper 

Press .1 2

Copying chart
paper

Chart paper can be attached to the screen as shown in the figure and
copied. (Be sure to take the chart off the screen soon after copying is
finished.)

CWrinkles, slackness or folds in the chart when attached to the screen will show up
in copies as dark shadows.

CAffix it to the screen with drafting tape made by 3M® or other similar tape with
medium adhesive.

3M® is a registered trademark of 3M Corporation.

1
2-Screen Copy

Front Back

2

Attach both
sides with
tape
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Replacing Thermal Transfer Film

Notes on Replacing Thermal Transfer Film

The unit is capable of producing about 15 more copies when the contrast/remaining film indicator begins to flash.
The unit has run out of thermal transfer film and can no longer make copies when the multi-copy/error indicator
flashes " ". Separately available replacement film (KX-BP081 or KX-BP082) may be purchased from the dealer
where you purchased the unit. Thermal transfer film is replaced as follows.

COnly use the designated product (KX-BP081 or KX-BP082) from Panasonic as the replacement
film. (Note that using another type of replacement film may result in degraded printing quality or
damage to the unit.)

CThermal transfer film is disposable. Dispose of used thermal transfer film as "burnable" or "non-
recyclable" rubbish.

CA negative of the copied image will remain on the thermal transfer film. To protect the security of
your information, we recommend cutting up used thermal transfer film with scissors or shredder
before disposing of it.

Film
Cassette Printer 

Open Lever

1 Push down the printer open lever to open the
printer door, and remove the film cassette with
both hands.

Thermal Transfer Film

Direction for 
Removing
Thermal 
Transfer Film

Blue Gear

Green Gear

Green Gears

Thermal 
Transfer Film

Film Cassette

2 Remove the used thermal transfer film from
the film cassette and remove the four gears.

3 Next, perform steps 3 to 7 in the section
entitled "Installing Thermal Transfer Film" that
can be found on page 14 and 15.
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Paper Jams
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Remove paper jams by the following procedure when copy paper does not come out of the output port or when " "
flashes on the multi-copy/error indicator.

Printer Door

Printer

Open Lever

1 Push down the printer open lever to open the
printer door.

Film
Cassette

2 Remove the film cassette with both hands.

Jammed Paper

3 Remove all jammed paper.

Slack Prohibited

Label

Thermal 
Transfer Film

4 If the thermal transfer film is slack, take up the
slack by winding the gears on the label side of
the cassette in the direction of the arrows.

CThe multi-copy/error indicator may flash 
" " if the thermal transfer film is slack. 
In addition, the thermal transfer film may
wrinkle, and blank (unprinted) spots or black
streaks may appear on the copy paper.

Download from Www.Somanuals.com. All Manuals Search And Download.



22

Paper Jams

Blue Label

Grooves

Grooves

5 Install the film cassette.

CInsert the film cassette into the printer so that
the blue gear on the cassette aligns with the
blue label on the printer and then insert the
gear shafts on both sides of the cassette into
the grooves inside the printer.

Printer Door

6 Close the printer door.

CSecurely close the printer door with both hands
until a click is heard.

CThe" " flashing on the multi-copy/error
indicator will go out.

CCIf the flashing " " does not go out after the foregoing procedure has been performed;
This may indicate that the paper feeder is not functioning properly. 
Reload the copy paper by following the steps given below.

Paper Cover

1 Turn the power off and on.

2 Open the paper cover and remove all copy
paper remaining inside the unit's paper cover.

CNote that the copy paper will slightly resist
being removed, but may be pulled out without
problems.

Download from Www.Somanuals.com. All Manuals Search And Download.



23

Paper Jams

U
sin

g

Maximum Paper Limit

Guide

3 To prevent paper jams such as those caused
by multiple sheets feeding, once fan the paper
thoroughly, square it, align it with the guide
inside, and insert as far as it will go.

CDo not stack more copy paper in the unit than
the maximum paper limit indicated by the guide
(see figure to the right) as this may result in
paper jams. [Note that the unit can hold about
80 sheets of paper having a weight of 80g/m2

(21 lbs).]

Note

Paper Cover

4 Close the paper cover.
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Before Using the Interactive Function
■ Setting the Electronic Pen

Marker for Interactive

Cap

Adaptor

Color 
Identification Cap

Remove the 
temporal cap.

3

1

2

2

Inserting

Pen Holder
Lever

Locking

Releasing

Marker for 
Interactive

3

1

23

+
-

+-

3
1

2

Battery
Cover

Pen Holder

1 Remove the battery cover on the pen holder,
insert the batteries as shown in the figure to
the right, and re-attach the battery cover.

CAlways use “AAA” size (alkaline) batteries and
be sure that their polarity is properly oriented.

CDo not mix old and new, different type batteries
when replacing batteries.

2 ~ 3mm (3/32" ~ 4/32" )

Remove the temporal cap, and set the cap and
adaptor to the marker for interactive.

CSecurely push the adaptor into the maker for
interactive as far as it will go.

CDo not remove the color identification cap on
the back end of the marker.

Rotate the pen holder lever to the release
position, insert the marker for interactive, and
then return the pen holder lever to the lock
position.

CLock the pen holder lever while inserting the
marker all the way into the pen holder until you
hear a buzzing sound.
Detection of the marker color may not work well
unless the marker is inserted fully into the pen
holder.

CDo not set the marker near the electronic print
board while using the interactive function as
this may appear unnecessary streaks not
written on the computer screen.

CPress down firmly with the point of the Electronic Pen on the screen film until you hear a buzzing sound.
CFor precise positioning, keep the Electronic Pen perpendicularly to the screen during use. Inclined pen angle will

cause the shift of position.

Note
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Before Using the Interactive Function

+
+

-

-
Eraser

Eraser

Cover

Electronic

3

1

2

4

Remove the eraser cover, insert the batteries as
shown in the figure to the right, and re-attach the
eraser cover.

CAlways use “AAA” size (alkaline) batteries and be
sure that their polarity is properly oriented.

CDo not mix old and new, different type batteries
when replacing batteries.

■ Setting the Electronic Eraser

■ Replacing the eraser cloth

Press

Hole

Eraser Cloth

1 Remove the eraser cloth by pushing through
the hole in the Electronic Eraser.

New Eraser Cloth

2 Attach a new eraser cloth by pressing around
the edge.

CPress down firmly with the eraser cloth of the Electronic Eraser on the screen film until you hear a buzzing sound.

Note
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Before Using the Interactive Function

■ Connecting to the PC

■ System requirements

Interactive Board

Interactive Cable

To the PC
(communication port)

Tray

Interactive
Connector

1 Connect one end of the proprietary interactive
cable supplied to the interactive connector
under the tray and the other end to the
computer's communication (COM) port.

CBe sure to turn off the electronic print board
and PC before you connect or take off the
interactive cable.

2 After connecting the interactive cable, securely
tighten the screws on the connector.

Computer: IBM® PC/AT or compatible machine with CD-ROM drive
CPU: Pentium® 150MHz or higher processor
Port: 9-pin communication (COM) port
Operating System: Windows® 95, Windows® 98, Windows® Millennium Edition,

Windows NT® 4.0 or Windows® 2000
Memory: 32MB or higher
Hard Disk Space: At least 10MB free space

Note

This cable is a proprietary interactive cable for
connecting the electronic print board with 
a PC.
Please do not use it with any other products.

Note
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Before Using the Interactive Function

■ Installing the software
In order to use interactive functions by connecting a computer and the
Interactive Panaboard, it is necessary to install the Interactive
Panaboard Software.
When you insert  the CD-ROM into the  CD-ROM drive, the Installation
Software will run *automatically. This will display the software menu on
the right. This menu consists of two sub menus;

Manuals
CCReadme - You can view the readme file
CCOperating Instruction – **You can view the Operating Instruction

Manual. 

Applications
CCInteractive Panaboard – This  install the software needed for the

Interactive Panaboard.

*Depending on the Operating System or the settings that you are using, the Automatic Installation Software may
not work. If this is the case please run the Installation Software "cdrun.exe" in the CD-ROM  through Windows
Explorer.

**Install Acrobat Reader 4.0 – Acrobat Reader is needed in order to view the Operating Instruction Manual.

CCInstalling the Interactive Panaboard Software

(1) Click “Interactive Panaboard” from software menu.

CCInstallation of the Interactive Panaboard Software will start.

(2) Follow the instructions on the screen to complete the installation.

CCWhen the installation of the Interactive Panaboard Software is completed, “Interactive Panaboard”
group will be entered under “Panasonic” at the Program menu.
Under the “Interactive Panaboard” group, there will be three items, Interactive Panaboard
Software, Help and Operating Instructions.

CCAdobe® Acrobat® Reader is necessary to refer to the Operating Instructions. 

CUninstalling the software
If you need to uninstall the Interactive Panaboard Software, please follow the following procedure.

(1) Click the [Start] button, and then click "Control Panel" in "Settings".
(2) Double-click "Add/Remove Programs" icon in the Control Panel.
(3) Select "Interactive Panaboard" in the Add/Remove Programs list, and click [Add/Remove] button.
(4) Follow the instructions on the screen to complete the uninstall.

Remark:
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Before Using the Interactive Function

CCInstalling Adobe® Acrobat® Reader

(1) Click "Acrobat (R) Reader" in Manuals group of the Automatic Installation Software.

CCInstallation of Adobe® Acrobat® Reader will start.

(2) Follow the instructions on the screen to complete the installation.

CCIn order to view the Operating Instruction Manual on the CD ROM, Reference of the
Interactive Panaboard Operating Instructions in CD-ROM
CCAdobe® Acrobat® Reader is necessary to refer to the Operating Instructions.

If it is not installed on your computer, install Adobe® Acrobat® Reader before refer to the Operating
Instructions.

(1) Click "Operating Instructions" in Manuals group of the Automatic Installation Software.

(2) You can see the Operating Instructions after Adobe® Acrobat® Reader runs automatically.
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Using the Interactive Panaboard Software
■ Start up the Interactive Panaboard Software

When the Projector mode is selected:
The calibration start screen will be displayed, then calibrate to adjust the position of the projected image and the
position of the Interactive Panaboard screen.
When the calibration is completed and the Projector mode become active, the icon will be registered in the
Taskbar and the Desktop Drawing Tool will appear automatically.

CIn the Projector mode, the Desktop Drawing Tool is used for operation.
The View window is used for playback and for editing a file which is recorded in the Projector mode.
For operation of the Projector mode, refer to "Projector Mode" from page 32.

When the Whiteboard mode is selected:
The icon will be registered in the Taskbar and the Whiteboard window will appear automatically.

CIn the Whiteboard mode, the contents of the drawing on the Interactive Panaboard Screen will be displayed in the
Whiteboard window.
The Whiteboard window is also used to playback and to edit a file which is recorded in the Whiteboard mode.
For operation of the Whiteboard mode, refer to "Whiteboard Mode" from page 43.

3 Click the [Start] button, and then click [Programs] · [Panasonic] ·
[Interactive Panaboard] · [Interactive Panaboard].

CThe Interactive Panaboard Software runs, and the COM detection
dialog box appears to show the Interactive Panaboard is detected.

4 Click the [OK] button.

CThe Select Mode dialog box will appear.

5 Click either the [Projector] button or the [Whiteboard] button, and
then click the [OK] button.

Remark:

CIf the Interactive Panaboard is not detected, the confirmation dialog box
appears.
In this case, check the condition of the Interactive Panaboard, the connection
of the Interactive Cable or the communication port setting.
To change the communication port setting, click [Setting...] button. (Refer to
page 30 "COM Port".)

CIf the Interactive Panaboard Software is used without connecting the Interactive Panaboard, click [Offline] button
in the connecting confirmation dialog box.
In the offline state, a file recorded in the Projector mode or the Whiteboard mode can be played back and edited.

CThe tool tip text displayed when the mouse is located over the icon in the Taskbar allows you to determine
the current mode.

Projector mode: "Interactive Panaboard (Projector)"
Whiteboard mode: "Interactive Panaboard (Whiteboard)"

1 Turn on the power of the Interactive Panaboard.

2 Turn on the computer's power and start up Windows.
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Using the Interactive Panaboard Software

■ Pop-up menu configuration of the Interactive Panaboard Software

■ Switching the mode

Right-click the in the Taskbar to get the pop-up menu.
Following operations are possible in the pop-up menu.

Select Mode... : Allow you to switch between modes (Projector mode/ Whiteboard mode).

Calibrate : Execute the calibration. (Projector mode only) ➡ Page 33

Tool Draw : Display the Desktop Drawing Tool. (Projector mode only) ➡ Page 36

View Window : Display the View window. (Projector mode only) ➡ Page 42
Open/Close

Whiteboard window : Switch the Whiteboard window open/close. (Whiteboard mode only) ➡ Page 45

Settings COM Port... : Set the communication port.

Adjustment... : Adjust the position of the Electronic Pen or the Electronic Eraser to 
improve the shifted position.

Options... : Set the option of the Interactive Panaboard Software.

Help Topics... : Display the help of the Interactive Panaboard Software.

About... : Display the Interactive Panaboard Software version information.

Exit : Exit the Interactive Panaboard Software.

You can freely switch the Projector mode and the Whiteboard mode while the
Interactive Panaboard Software is running.

■ Settings of the Interactive Panaboard Software

CCOM port
Setup the communication port to communicate with the Interactive Panaboard.

1 Right-click the icon in the Taskbar and click [Select Mode...] in
the pop-up menu. In addition, you can double-click the icon in
the Taskbar.

CThe Select Mode dialog box will appear.

(1) Right-click the icon in the Taskbar and click [Settings] · [COM
port...] in the pop-up menu.

CThe COM port dialog box will appear.

(2) Click the [Start...] button of the Auto Detection to detect the communication port
connected with the Interactive Panaboard automatically.
Otherwise, click the arrow at the bottom on the right side of the [COM port] box and then
click the communication port from the list.

(3) Click the [OK] button.

2 Click either the [Projector] button or the [Whiteboard] button, and then click the [OK] button.

CWhen switching to the Projector mode, the calibration screen will not be displayed automatically
after calibration ended correctly once. Please calibrate if necessary.

CWhen switching to the Whiteboard mode, the Whiteboard window will be displayed.

Download from Www.Somanuals.com. All Manuals Search And Download.



31

U
sin

g

Using the Interactive Panaboard Software

CAdjustment
The Electronic Pen or the Electronic Eraser position may largely shift by the
using environment. In this case, adjust the position according to the following
procedures to improve the shifted position.

(1) Right-click the icon in the Taskbar and click [Settings] ·
[Adjustment...] in the pop-up menu.

CCThe Adjustment dialog box will appear.

(2) Place the Electronic Pen at the center of the Interactive
Panaboard screen and drag slowly the Electronic Pen
downward about 100mm (4").

CCWhen the adjustment is finished, the adjustment end message will be displayed in the Adjustment
dialog box and the [Cancel] button will be changed into the [OK] button.

(3) Click the [OK] button.

CCOptions
Set-up the option of the Interactive Panaboard Software.

(1) Right-click the icon in the Taskbar and click 
[Settings] · [Options...] in the pop-up menu.

CCThe Options dialog box will appear.

(2) The following options can be set.

Show Desktop Drawing Tool when Projector Mode starts:
When this is selected, the Desktop Drawing Tool is automatically displayed after the Projector mode
starts.

Print out image automatically rotates to fit printer paper direction:
When this is selected, the printing image automatically rotates to fit the direction of paper set in a printer.

(3) Click the [OK] button.

CFor precise adjusting, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen during the
adjustment. Inclined pen angle will cause the shift of position.

CTo cancel the adjustment, click the [Cancel] button by a mouse of the computer.

■ Reference the help

■ Display the information about the Interactive Panaboard Software

■ Exiting the Interactive Panaboard Software

Right-click the icon in the Taskbar and click [Help Topics...] in the pop-up menu.

CThe topics on the online help are displayed.

Right-click the icon in the Taskbar and click [About...] in the pop-up menu.

CThe version information of the Interactive Panaboard Software is displayed.

Right-click the icon in the Taskbar and click [Exit] in the pop-up menu.

CThe Interactive Panaboard Software ends.

Note
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Projector Mode

Electronic Print Board

Position Receiver

50mm (2")

Position Receiver

Interactive
Upper Limit Mark

Interactive Upper 
Limit Mark

Screen Film

Projector

35mm
(13/8")

100mm (13/8")

100mm (13/8")

35mm
(13/8")

CWhen using a projector to project images, be sure to display the image so that it is centered left-to-right
on the electronic print board screen and with at least a 50 mm (2") gap between the top of the image
and the screen border. Note that the Electronic Pen does not always operate properly when within 50
mm (2") of the top of the screen, 100 mm (315/16") of the position receiver and 35 mm (13/8") from the both
sides of the screen.

CSince the Electronic Pen position may shift if the image on the screen is trapezoidal, adjust the projector
so that the image on the screen is rectangular.

CWhen projecting an image on the electronic print board using a projector, the image on the screen may
become difficult to see depending on the viewing angle and position due to reflected projector light. 
If this happens, adjust the location of the projector or change your viewing position.

CWhen using a projector to project a PC screen, be sure to use optimum resolution settings for the
projector and the PC. The image may be difficult to see if optimum settings are not used. Fine lines in
the image on the electronic print board screen may appear broken particularly if the projector resolution
is lower than the PC resolution.

CWhen using a projector to project images, the Electronic Pen position may shift if the projection position
shifts due to the following causes. If this happens, it becomes necessary to perform calibration to re-
position the projected image on the screen. (For details on calibration, please see page 33.)

BWhen the installed location of the projector is changed.

BWhen the position of the electronic print board is changed.

BWhen the projection area and position has changed due to using a projector function such as zoom.

BWhen the display resolution of the projector or PC has changed.

CNote that the position of an electronic print board attached to a stand may shift if it is struck carelessly.
Always make sure the stand's casters are locked in place.

CLight from the projector may enter the eye when using a projector to project images for the purpose of
making presentations and so on. Be very careful as direct projector light may hurt the eyes.

■ Precautions when using a projector

Do not use the shaded area.
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Projector Mode

■ Basic operation flow in Projector mode
This section explains the flow of basic operations when using the Interactive Panaboard Software in the Projector
mode. We recommend trying the operations in accordance with the following steps to help you completely
understand the operations in the Projector mode.
CFor any explanations on the operations of the Projector mode, the Electronic Pen will be referred to as "Mouse"

and the projected computer screen on the Interactive Panaboard will be referred to as "Desktop".

CCalibration
Calibration is an operation to calibrate the
position of the computer screen projected onto
the Interactive Panaboard screen to judge the
position by the Interactive Panaboard Software.

(1) Start the Interactive Panaboard
Software and select the Projector
mode. (See page 29.)

CThe calibration screen is displayed.

(2) In the sequence of upper left, upper
right, lower right and lower left, press for about two seconds for center of each four corner
position with the Electronic Pen.

CWhen this operation ended correctly, then the next position starts automatically.

(3) When the calibration ended correctly, there is a message telling you its finish. From this
point onward, the Electronic Pen can be used as the Mouse.

CIf recalibration is necessary, click [Calibrate] in the pop-up menu.

Note

Remark:

Place the
Electronic Pen
on this position
and depress it.

CIf you move the projector or  Interactive Panaboard, the position of the computer screen projected onto the
Interactive Panaboard screen will be changed. This will result in out of position of the Electronic Pen. If this
happens, you will need to recalibrate the unit by executing [Calibrate] in the pop-up menu.

CIn the Projector mode, use the Electronic Pen with its cap on.
CDo not cover the position receiver with your hand as this may cause interactive function to stop functioning.
CPress down firmly with the point of the Electronic Pen on the screen film until you hear a buzzing sound.
CFor precise positioning, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen during

use. Inclined pen angle will cause the shift of position.

Download from Www.Somanuals.com. All Manuals Search And Download.



34

Projector Mode

CUse the Electronic Pen as a mouse
After the calibration is completed, the Electronic Pen can be used as a mouse for the projected computer screen
on the Interactive Panaboard.

CIf double-click does not work properly, confirm that the same position is accurately clicked twice. 
When the position is different, it is not recognized a double click.
Or, try different timing of depressing and releasing of the Electronic Pen. This operation is also depending on
the setting of the double-click speed of the [Control Panel].

Note

Remark:

CFor precise positioning, keep the Electronic Pen perpendicularly to the Interactive Panaboard screen
during use. Inclined pen angle will cause the shift of position.

CDraw and erase handwritten lines on the Desktop

(1) Click either (Black, Red, Blue or Green Marker) in the Desktop Drawing Tool to
draw handwritten lines.

CThe shape of the mouse cursor changes to .

(2) Position the mouse pointer where you want to draw a handwritten line on the
Desktop and drag the Mouse.

(3) Click (Eraser) in the Desktop Drawing Tool to erase the handwritten line.

CThe shape of the mouse cursor changes to .

(4) Drag the Mouse to the area on the Desktop to be erased.

CThe width and color of the markers and the size of the eraser can be changed. (See page 38.)

(1) If the Desktop Drawing Tool is not displayed, right-click the icon in the Taskbar
and click [Tool] · [Draw] to display the Desktop Drawing Tool.

(2) To use the Electronic Pen as a mouse, click (Arrow) in the Desktop Drawing Tool.
Operations of "click" and "drag" are as follows.

CSingle click: Press the projected screen with the tip of the Electronic Pen.

CDouble-click: Double-click is executed by performing two quick clicks at the same position with
the tip of the Electronic Pen.

CDrag: Press and hold the desire image with the tip of the Electronic Pen while dragging
the image to its new position.

CRight-click: Locate light gray button on the Electronic Pen. While pressing the button of the
Electronic Pen, press the projected screen with the tip of the Electronic Pen and
release. (Do not release the button of the Electronic Pen before all of these
operations are finished.)

For more details about the Desktop Drawing Tools, please refer to "About Desktop
Drawing Tool" from page 36.

Remark:
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CRecord image and handwritten lines data on the Desktop
Data of handwritten lines drawn or erased on the Desktop using the Desktop Drawing Tool can be recorded in
Interactive Panaboard format files (extension ".ipb", referred to as IPB documents) along with the initial Desktop
image.
Written or erased handwritten lines are recorded in stroke units and can be displayed, played back and edited
later in the View window.

(1) Click (REC Start) in the Desktop Drawing Tool.

CIf there are drawn lines on the Desktop, a verification dialog box will appear to confirm whether to
erase drawings.
To erase the drawn lines and start recording, click [Yes] button.
To leave the drawn lines and start recording, click [No] button. In this case, drawn lines become a
part of background image.

CThe image of the Desktop is displayed in the dialog box.

(2) If it is acceptable to store as a background image, click the [OK] button.

(3) Draw lines by using (Black, Red, Blue or Green Marker) or erase drawn line by 
(Eraser) in the Desktop Drawing Tool.

(4) After finishing your drawing and erasing, click (REC Stop) in the Desktop Drawing Tool.
CThe recording image will be displayed in a dialog box.

(5) Click the [OK] button to record the recording image.

CThe Save As dialog box will appear.

(6) Enter the folder where you want to save the file and the file name.

CThe extension of the file is ".ipb".

(7) Click the [Save] button.

CMore than one page can be recorded. (See page 40.)

Note

Remark:

CDo not change the Desktop resolution while recording data. If changed, the Desktop image will not be
displayed properly when it is displayed in the View window.

(1) If the View window is not displayed, right-click the icon in
the Taskbar and click [Tool] · [View Window] to display the
View window.

(2) Click [Open...] in the [File] menu.

CThe Open dialog box will appear.

(3) Enter the folder to look in and the file name you want to open. 

CThe file has an ".ipb" extension.

(4) Click the [Open] button.

CPlayback the recorded data by View window
Desktop background data and handwritten lines data stored using the Desktop Drawing Tool can be displayed
in the View window as well as browsed, played back and edited.
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CMany different operations can be executed in the displayed IPB document.
Save the IPB document in another file format. (See page 50.)
Switch a page of the IPB document. (See page 54.)
Edit a page of the IPB document. (See page 54.)
Playback the IPB document. (See page 57.)
Print the IPB document. (See page 58.)

■ About Desktop Drawing Tool
The Desktop Drawing Tool is a tool for drawing, erasing, recording, etc. on the Desktop.
In the Projector mode, click [Tool] · [Draw] in the pop-up menu. The Desktop Drawing Tool will be appeared
when there is a check mark. While the Desktop Drawing Tool is being displayed, click [Tool] · [Draw] in the
pop-up menu. This will delete the check mark and the Desktop Drawing Tool will disappear.
The Desktop Drawing Tool is always displayed at the front of the Desktop. From this Desktop Drawing
Tool, the tools can be selected for drawing or erasing lines.
The data drawn on the Desktop can be stored into the IPB document together with the desktop image.
They can be displayed or edited by the View window.

In the Desktop Drawing Tool, following tools can be used.

CThe standard display condition

Arrow: Use the electronic pen as the Mouse.

Black Marker: By dragging the Mouse, black line can be drawn.

Red Marker: By dragging the Mouse, red line can be drawn.

Blue Marker: By dragging the Mouse, blue line can be drawn.

Green Marker: By dragging the Mouse, green line can be drawn.

Eraser: By dragging the Mouse, lines can be erased.

Setting: The width, color of the markers and size of the eraser can be changed.

All Clear: Clear all drawn lines.

Capture: Output the Desktop image as an image file.

Print: Print out the Desktop image.

White Background: Change the background of the Desktop to the whiteboard.
Click once again will release the Whiteboard status.

Refresh: All of the drawn lines on the Desktop are re-displayed.

REC Start: Start recording of the data.
The capture image of the Desktop is added as an initial data.

Remark:
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Projector Mode

REC Stop: Stop recording and store the recording data.

Page No.: Display the page number which is being recorded.
Before recording, it is (0). When the Recording start button is depressed, it 
displays as (1), and following pages will be numbered accordingly.

New Page: Saves current page recordings and starts the process to record the next page.
Selecting this icon will stop the recording of the current page. The recording 
process will be paused while the current page is saved and the background for 
the next page is changed and confirmed.
To start the recording process of the next page, select the (REC Start) 
icon.

Minimum: Shrink the size of the Desktop Drawing Tool.

CShrunken display condition

Selected tool: Display the current selected tool.

Maximum: Return to the standard display condition of the Desktop Drawing Tool.

(1) Click either (Black Marker, Red Marker, Blue Marker or Green Marker) in the Desktop
Drawing Tool.

CThe shape of the mouse cursor changes to .

(2) Position the Mouse where you want to draw a handwritten line on the Desktop and drag
the Mouse.

(3) Click (Eraser) in the Desktop Drawing Tool.

CThe shape of the mouse cursor changes to .

(4) Drag the Mouse to the area on the Desktop to be erased.

CDraw and erase handwritten lines

■ Desktop Drawing Tool operation

CThe width and color of the markers and the size of the eraser can be changed. (See page 38.)
CHandwritten lines drawn on the Desktop may be hidden or shifted when an application or a window are

operated. If this occurs, click (Refresh) to redisplay the Desktop.

Remark:

CWhen the Desktop Drawing Tool is closed, the drawings are erased.

Remark:
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(1) Click (Setting) in the Desktop Drawing Tool.

CCThe Marker/Eraser Setting dialog box will appear.

(2) To change the width of the markers, either enter a 

width in (Marker Width) at the right side
of the marker whose width will be changed or click the up/down arrows on the right side to
set a desired width.

To change the color of the markers, click (Marker Color) on the right side of the
marker whose color will be changed. The Color dialog box will appear. Click the color you
want to change from among Basic colors, and click the [OK] button.

To change the size of the eraser, either enter a size in (Eraser Radius) or click
the up/down arrows on the right side to set a desired size.

(3) Click the [OK] button.

(4) A dialog box will appear where you can select whether or not to apply the new settings to
handwritten lines drawn up to now.
Clicking [Yes] button will redraw the lines drawn up to that point using the new settings.
Clicking [No] button will only reflect the new settings for any subsequently drawn lines.

CThe marker width can be set in a range of 1 - 30 dots.
CEven though the marker colors are changed, the colors of the Desktop Drawing Tool buttons and the mouse

cursor will not change.
CThe eraser radius can be set in a range of 1 - 60 dots.
CThese settings are effective until being changed.

38
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CCChange Marker/Eraser settings
Change the width and color of the markers and the size of the
eraser used in the Desktop Drawing Tool. 
The marker width and color can be changed for four marker
colors.

Remark:

(1) Click (All Clear) in the Desktop Drawing Tool.

CCA verification dialog box will appear.

(2) Click the [OK] button to execute all clear.

CCErase all handwritten lines on the Desktop
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Projector Mode

(1) Click (Refresh) in the Desktop Drawing Tool.

CCRedisplay handwritten lines drawn on the Desktop
Handwritten lines drawn on the Desktop may be hidden or shifted when an application or a window are
operated. If this occurs, redisplay the Desktop.

CCSave Desktop in image file
Save the background image of the Desktop and handwritten lines that were drawn on the Desktop as an image
file.

(1) Click (Capture) in the Desktop Drawing Tool.

CCThe Save As dialog box will appear.

(2) Enter the folder where you want to save the file, the file name and the file type.
The following file formats can be selected for the [File type].

Bitmap Files (*.bmp), TIFF Files (*.tif) or JPEG Files (*.jpg)

(3) Click the [Save] button.

CCPrint an image of the Desktop
Print the background image of the Desktop and handwritten lines that were drawn on the Desktop.

(1) Click (Print) in the Desktop Drawing Tool.

CCThe Print dialog box will appear.

(2) Set the [Printer] and [Number of copies].

(3) Click the [OK] button.

CCThe Printing dialog box will appear.
CCTo stop the printing, click the [Cancel] button in the Printing dialog box.

CCSet the background of the Desktop to the Whiteboard
Allow you to make the background of the Desktop totally white.

(1) Click (White Background) in the Desktop Drawing Tool.

CCIn addition, click (White Background) again to return the background of the Desktop to its
original sate.
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(1) Click (REC Start) in the Desktop Drawing Tool.
CCIf there are drawn lines on the desktop, a verification dialog box will appear to confirm whether to

erase drawings.
To erase the drawn lines and start recording, click [Yes] button.
To leave the drawn lines and start recording, click [No] button. In this case, drawn lines become a
part of background image.

CCThe image of the Desktop will be displayed in a dialog box.

(2) Click the [OK] button to store the data as the background image of the 1st page.

(3) Use the (Black Marker, Red Marker, Blue Marker or Green Marker) in the Desktop
Drawing Tool to draw handwritten lines.
In addition, use the (Eraser) to erase unwanted handwritten lines.

(4) Click (New Page) to add a page.
If no pages will be added, advance to step 11.
CCThe recording image will be displayed in a dialog box.

(5) Click the [OK] button to record the recording image.
CCA verification dialog box will appear to confirm whether to erase the drawings.

(6) Click the [Yes] button to erase the drawings.
Or, click the [No] button to leave the drawings as a part of background image of a new
page.
CCThe recording process is paused. The Electronic Pen cursor will automatically change to the

mouse arrow cursor, allowing the background image to be changed.
While the recording process is paused, all of the Desktop Drawing Tool icons are inactive except
the (REC Start) and (White Background) icons.

(7) Switch the Desktop to the desired background.

(8) Click (REC Start) to restart the recording of a new page.
CCThe image of the Desktop will be displayed in a dialog box.

(9) Click the [OK] button to store the data as the background image of a new page.
CCAll of the Desktop Drawing Tool icons will become active.

(10) To add multiple pages, repeat steps 3 to 9.

(11) Click (REC Stop) in the Desktop Drawing Tool.
CCThe recording image will be displayed in a dialog box.

(12) Click the [OK] button to record the recording image.
CCThe Save As dialog box will appear.

(13) Enter the folder where you want to save the file and the file name. 
CCThe extension of the file is ".ipb".

(14) Click the [Save] button.

CCRecord drawing data in IPB document
Create an IPB document to record work performed on the Interactive Panaboard.
Clicking (REC Start) in the Desktop Drawing Tool will record the Desktop image at that moment as a
background and any handwritten lines drawn or erased on the Desktop on a page in stroke units.
A page is a unit of recorded work performed on the Desktop. If (New Page) is used to add a page when
switching screens on the Desktop, the contents of the Desktop and the page can be synchronized.
The recording operation will stop when (REC Stop) is clicked and the data saved as an IPB document.
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Projector Mode

(1) Click (Minimum) in the Desktop Drawing Tool.

CCClick (Maximum) to return the Desktop Drawing Tool to its normal display size.

CTools cannot be changed when displayed at a reduced size.

CCReduce display size of the Desktop Drawing Tool
The Desktop Drawing Tool can be displayed at a reduced size.
When the screen is hidden by the Desktop Drawing Tool, executing this reduction in display size will allow you
to reduce the hidden portion to its minimum size.

CWhile recording data, page numbers can be verified by (PageNo) in the Desktop Drawing Tool. Before
starting to record data, the data value is "0" and will change to "1" when       (REC Start) is clicked.
The value will then count up for each page break.

CWhen switching the computer screen being projected onto the screen of the Interactive Panaboard during a
meeting, begin drawing after adding (New Page) and recording the background image of the new page.

CA maximum of 50 pages can be stored.

Note

Remark:

CDo not change the Desktop resolution while recording data. If changed, the Desktop image will not be
displayed properly in the View window.

Remark:
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#Title bar

&[Main] Toolbar

&[Page/Play] Toolbar

&[Markers/Eraser] Toolbar

$Main view

%Thumbnail view

(Replay mode )Image size *Page number

'Status bar

# Title bar: Indicate the currently opened file name of the IPB document.

$ Main view: In the main view, the page to be edited is displayed.
When (Arrow) is selected in the [Markers/Eraser] Toolbar, a part of page can be copied
into the Clipboard by dragging the mouse. It can be copied to other application software by
drag and drop.
When marker is selected in the [Markers/Eraser] Toolbar, you can draw lines on the page. If
the eraser is selected, you can erase the lines.

% Thumbnail view: The thumbnail image of the all pages of the IPB document can be displayed.
At the bottom of each page, the last modified date is displayed.
The image in the main view area is indicated as framing in the thumbnail area. To change
the editing page, click another page.

& Toolbar: Toolbar has buttons which most frequently used functions are formed as icon.
It can be moved in the display area by dragging.

' Status bar: Indicate the information of the IPB document.
( Replay mode: Indicate if it is in the replaying or not.
) Image size: Indicate the page size when it is 100% display ratio.
* Page number: Indicate the total number of pages and the page being displayed.

For more details about the View window, refer to "View Window or Whiteboard Window Operation" from page 46.

■ About View window
Desktop background data and data of handwritten lines recorded using the Desktop Drawing Tool can be
displayed in the View window as well as browsed, reproduced and edited.
In the View window, display and edit of the IPB documents which is recorded by the Desktop Drawing Tool are
possible.

In the Projector mode, click [Tool] · [View Window] in the pop-up menu to get the check mark, then the View
window will appear.
While displaying the View window, click [Tool] · [View Window] in the pop-up menu to delete the check mark, then
the View window will disappear.
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Whiteboard Mode

(1) Start the Interactive Panaboard Software and select the
Whiteboard mode. (See page 29.)

CCThe Whiteboard window is displayed.

(2) Remove the cap of the Electronic Pen and draw on the
Interactive Panaboard screen using the Electronic Pen.

CCThe position on the screen where you are drawing will be
reproduced on the page in the Whiteboard window in real-
time.

(3) Erase handwritten lines drawn on the Interactive Panaboard screen using the Electronic
Eraser.

CCPortions erased on the screen will also be erased on the page in the Whiteboard window.

■ Basic operation flow in Whiteboard mode
This section explains the flow of basic operations when using the Interactive Panaboard Software in the
Whiteboard mode. We recommend trying the operations in accordance with the following steps to help you
completely understand the operations in the Whiteboard mode.

CCDrawing and erasing handwritten lines on the Interactive Panaboard screen
When the Whiteboard window is displayed, set one of the four different types of the markers for interactive
(Small) used for the Electronic Pen, remove the cap and draw on the Interactive Panaboard. The content of the
drawing will be displayed on a page in the Whiteboard window in real-time. Further, if you use the Electronic
Eraser to erase the contents drawn on the screen, the handwritten lines displayed on the page in the
Whiteboard window will be erased as well.
These drawing and erasing operations are recorded automatically.

Note

CThe right figure shows the writing area in the Whiteboard mode.
Do not write the shaded area on the right figure.

CDo not cover the position receiver with your hand as this may cause
interactive function to stop functioning.

CPress down firmly with the point of the Electronic Pen or the eraser
on the screen film until you hear a buzzing sound.

CDo not do the followings near the Interactive Panaboard while using
the Whiteboard mode as this may display unnecessary streaks not
written in the Whiteboard window.

- Exchanging markers for interactive (Small) of the Electronic Pen
- Setting or removing a marker cap of the Electronic Pen
- Pushing the point of the Electronic Pen

CWhen exchanging markers for interactive (Small) of the Electronic
Pen, lock the pen holder lever while inserting the marker all the way into the pen holder until you hear a
buzzing sound.
Detection of the marker color may not work well unless the marker is inserted fully into the pen holder.

CWhen advancing the screen of the Interactive Panaboard, click [Add New Page] in the [Edit] menu to add a
new page.

Remark:

Writing area

50mm (2")

25mm (1")

35mm
(13/8")

100mm
(315/16")

35mm
(13/8")

Position
Receiver

Download from Www.Somanuals.com. All Manuals Search And Download.



44

Whiteboard Mode

CMany different operations can be executed in the displayed IPB document.
Save the IPB document in another file format. (See page 50.)
Switch a page of the IPB document. (See page 54.)
Edit a page of the IPB document. (See page 54.)
Playback the IPB document. (See page 57.)
Print the IPB document. (See page 58.)

CCOpen the saved data
The saved data can be displayed in the Whiteboard window as well as browsed, played back and edited.

(1) Click [Open...] in the [File] menu.

CCThe Open dialog box will appear.

(2) Enter the folder to look in and the file name you want to open.

CCThe file has an ".ipb" extension.

(3) Click the [Open] button.

(1) Click [Save As...] in the [File] menu.

CCThe Save As dialog box will appear.

(2) Enter the folder where you want to save the file and the file name.

CCThe extension of the file is ".ipb".

(3) Click the [Save] button.

CCSave drawing data in a file
All drawing and erasing operations of the Interactive Panaboard which are reproduced on a page in the
Whiteboard window are automatically recorded. And if the data is saved in the Interactive Panaboard format file
(extension ".ipb", referred to as IPB documents), the details of meetings and discussions written in the
Panaboard can be played back and edited later.

Remark:
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■ About Whiteboard window
Whiteboard window is a function to reproduce the drawn lines by using the Electronic Pen and the Electronic
Eraser onto the Interactive Panaboard to the computer screen.
Recorded image data can be saved as IPB document. So that you can see the file later. The following functions
are available; Add lines with marker. Erase unnecessary lines with eraser. Copy entire page or partial image to
other general image formats such as Bitmap, JPEG, TIFF and these images can be transferred to other application
software.

Either start with the Whiteboard mode or click [Open Whiteboard Window] in the pop-up menu to get the check
mark in the Whiteboard mode, then the Whiteboard window will appear.
While displaying the Whiteboard window, click [Close Whiteboard Window] in the pop-up menu to delete the check
mark, then the Whiteboard window will disappear.

#Title bar

&[Main] Toolbar

&[Page/Play] Toolbar

&[Markers/Eraser] Toolbar

$Main view

%Thumbnail view

(Replay mode )Image size *Page number

'Status bar

# Title bar: Indicate the currently opened file name of the IPB document.

$ Main view: In the main view, the page to be edited is displayed.
When (Arrow) is selected in the [Markers/Eraser] Toolbar, a part of page can be copied
into the Clipboard by dragging the mouse. It can be copied to other application software by
drag and drop.
When marker is selected in the [Markers/Eraser] Toolbar, you can draw lines on the page. If
the eraser is selected, you can erase the lines.

% Thumbnail view: The thumbnail image of the all pages of the IPB document can be displayed.
At the bottom of each page, the last modified date is displayed.
The image in the main view area is indicated as framing in the thumbnail area. To change
the editing page, click another page.

& Toolbar: Toolbar has buttons which most frequently used functions are formed as icon.
It can be moved in the display area by dragging.

' Status bar: Indicate the information of the IPB document.
( Replay mode: Indicate if it is in the replaying or not.
) Image size: Indicate the page size when it is 100% display ratio.
* Page number: Indicate the total number of pages and the page being displayed.

For more details about the Whiteboard window, refer to "View Window or Whiteboard Window Operation" from
page 46.
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View Window or Whiteboard Window Operation
■ Differences between the View window and the Whiteboard window

The View window of the Projector mode and the Whiteboard window of the Whiteboard mode are windows which
function to display and edit IPB documents in which the contents of work performed on the Interactive Panaboard
are recorded. Basically, they both have identical functions. However, the Whiteboard window has some functions
the View window does not have. If you understand the differences between the two windows as follows, you will be
able to quickly use both windows just by learning the operations of one window.

Difference

System of units

[File] menu

[New]:

[Edit] menu

[Add New Page]:

[Edit] menu

[Add Copy Page]:

CThe View window displays IPB documents which record work done in the computer
screen that is projected onto the Interactive Panaboard screen by the projector.
Consequently, the size is represented by dots.

CIn the Whiteboard window the state of the Interactive Panaboard screen where the
marker was used to draw is virtually displayed in a computer window. Consequently,
units of length are standard. You can choose between units in millimeters or inches.

CThe View window function displays and edits IPB documents created by the Desktop
Drawing Tool. Consequently, the [New] menu does not exist.

CClose the IPB document currently displayed in the Whiteboard window and displays a
new IPB document.

CThe View window function displays and edits IPB documents created by the Desktop
Drawing Tool. Consequently, the [Add New Page] menu does not exist.

CAdd a new page that has no drawing data next to the last page of the IPB document in
the Whiteboard window.

CThe View window function displays and edits IPB documents created by the Desktop
Drawing Tool. Consequently, the [Add Copy Page] menu does not exist.

CAdd a copy of the page displayed next to the last page of the IPB document in the
Whiteboard window.

Details

■ Menu configuration
Following menus can be used in the View window or the Whiteboard window.

[File] menu

New: Close the displayed IPB document, create a new IPB document.

(Whiteboard window only) ➡ Page 49

Open: Open an IPB document. ➡ Page 49

Save: Save the displayed IPB document. ➡ Page 50

Save As: Save the displayed IPB document with new file name. ➡ Page 50

Print Preview: Before printing, check printing layout the displayed IPB document. ➡ Page 58

Print: Print the displayed IPB document. ➡ Page 58
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View Window or Whiteboard Window Operation

Export    Image: Output the page to the image file (Bitmap, JPEG, TIFF). ➡ Page 50

HTML: Output the page to the HTML file. ➡ Page 51

Close View window: Close the View window. (View window only)

Close
Whiteboard window: Close the display of the Whiteboard window.

(Whiteboard window only)

[Edit] menu

Undo: Return the drawing lines line by line. ➡ Page 55

Redo: Cancel the undo. ➡ Page 55

Copy: Copy the selected area in the page to the clipboard.
The page size to be copied is 100% zoom condition. ➡ Page 56

Select All: Select entire page. ➡ Page 56

Add New Page: Add a new page next to the last page. (Whiteboard window only) ➡ Page 55

Add Copy Page: Add copied page next to the last page.  (Whiteboard window only) ➡ Page 55

Delete Current Page: Delete the displayed page. ➡ Page 56

[Page/Play] menu

Start: Start the replay. ➡ Page 57

Pause: Pause the replay. ➡ Page 57

Stop: Stop the replay. ➡ Page 57

Go to First Page: Display the first page. ➡ Page 54

Go to Previous Page: Display the previous page. ➡ Page 54

Go to Next Page: Display the next page. ➡ Page 54

Go to Last Page: Display the last page. ➡ Page 54

Go to Page: Display the specified page. ➡ Page 54

[View] menu

Zoom    Fit Window: Display the current page to fit window. ➡ Page 53

200%: Display the current page by 200% of its original size. ➡ Page 53

150%: Display the current page by 150% of its original size. ➡ Page 53

100%: Display the current page by 100% of its original size. ➡ Page 53

75%: Display the current page by 75% of its original size. ➡ Page 53

50%: Display the current page by 50% of its original size. ➡ Page 53

25%: Display the current page by 20% of its original size. ➡ Page 53

10%: Display the current page by 10% of its original size. ➡ Page 53

Full Screen: Use the entire display area of your monitor to display the current page.

➡ Page 53
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Main Toolbar: Switch the Main Toolbar display ON/OFF. ➡ Page 48

Page/Play: Switch the Page/Play Toolbar display ON/OFF. ➡ Page 48

Markers/Eraser: Switch the Markers/Eraser Toolbar display ON/OFF. ➡ Page 49

Status Bar: Switch the Status bar display ON/OFF.

[Settings] menu

Information: Store the information of the meeting. ➡ Page 58

Play: Change the interval time when replaying the drawing data. ➡ Page 59

Markers and Eraser: Change the color and size of the marker and size of the eraser. ➡ Page 59

Export Image: Set the quality of JPEG or compression of TIFF etc. ➡ Page 60

File: Change the folder of IPB document management default or automatic back up
interval timing. ➡ Page 61

Options: Set the measurement unit such as mm or inch and the File path display method to
the title bar. ➡ Page 62

[Help] menu

Help Topics: To display help information.

About: To display information about the Interactive Panaboard Software.

■ Tool bars
Following menus can be used in the View window or Whiteboard window.

*The [New] button is only for the Whiteboard window.

CMain Toolbar

CPage/Play Toolbar

ZoomCopySave

New Open Print Fit Window Full Screen

Go to Last PageGo to Previous PageStopPause

Go to Next PageGo to First PagePlay Scroll barStart
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View Window or Whiteboard Window Operation

■ Create an IPB document (Whiteboard window only)
In the Whiteboard mode, create new IPB document to record work performed on the Interactive Panaboard.

■ Open an IPB document

CThe Toolbars can be dragged and moved to any location on the screen.

CWhen the Whiteboard window is displayed, an IPB document is automatically created and a new page is
displayed in the main view.

CWhen advancing the screen of the Interactive Panaboard during a meeting, add a new page by [Add New Page]
in the [Edit] menu.

CMarkers/Eraser Toolbar

To display a Toolbar, click the [View] menu and then click the Toolbar you want to display (any one of [Main],
[Page/Play], [Markers/Eraser]) and add a check mark.
If the Toolbar is already displayed, add a check mark next to that Toolbar.
To turn off the Toolbar, click [View] menu and remove the check mark from the Toolbar you want to hide.
If the Toolbar is not displayed, a check mark will not be added next to that Toolbar.

1 Click [Open...] in the [File] menu.

CThe Open dialog box will appear.

2 Enter the folder to look in and the file name you want to open. 

CThe file has an ".ipb" extension.

3 Click the [Open] button.

Eraser
Blue Marker

Black Marker

Arrow Green Marker
Red Marker

Remark:

Remark:

1 Click [New...] in the [File] menu.

CWhen the IPB document currently being edited is changed, a dialog box will display asking you to
confirm the save.
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CTo open a recently opened file, click the file name you want to open in the [File] menu. Eight recently opened
IPB documents will be displayed in the [File] menu.

CThe IPB documents can also be opened by double-clicking the file icon in the file system.
Whether an IPB document is created in Projector mode or Whiteboard mode, the contents are managed
internally and when opened, the mode they were created in will be switched to automatically.

CTo allow a previously saved IPB document to be recovered if a power failure or other incident occurs, add a
check mark to the [Create Recovery File] check box in the [File Settings] dialog box ([Settings] · [File...]) in
advance.
Open the recovery file setting [All Files] in the [Files of type] box as the recovery file have an ".ip~" extension.

■ Save the IPB document

Click [Save] in the [File] menu.

CTo save a currently open IPB document with a different name, click [Save As...] in the [File] menu.

■ Save the IPB document in another file format
Exporting images allows you to save files in another file format to allow the IPB documents to be used in other
applications. This makes it possible to easily distribute the contents of meetings stored in the IPB document to
users whose computers do not have the Interactive Panaboard Software installed.

(1) Click [Export] · [Image...] in the [File] menu.

CCThe Export Image dialog box will appear.

(2) To save all the pages, click [All pages].
In addition, to specify certain pages to be saved, click
[Page from] and then enter the page range.
Clicking the [Setup] button will allow you to set image size, JPEG file quality and TIFF file
compression.

(3) Click the [OK] button.

CCThe Save As dialog box will appear.

(4) Enter the folder where you want to save the file, the file name and the file type.

The following file formats can be selected for the [Save as type].
Bitmap Files (*.bmp), TIFF Files (*.tif) or JPEG Files (*.jpg)

(5) Click the [Save] button.

CCSave the IPB document as an image file

Remark:

Remark:
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View Window or Whiteboard Window Operation

CWhen saving multiple pages, files for a certain number of pages (for example, n pages) are created and 2
digits "01, 02, --- 0n" to represent the page are added on the end of the file name.

CSettings such as size and compression when saving the IPB document as an image file are managed in
[Export Image...] in the [Settings] menu.

CCSave the IPB document as a HTML file
You can save the IPB document as a HTML file in page units. 
In addition, meeting information can also be output at the same
time to that index page.
Setting multiple pages and saving the IPB document as a HTML
file will create an index file, linked HTML pages and images.
Using this method will allow the contents of meetings recorded in
the IPB documents to be easily provided to people using
computers with Web browsers installed.

(1) Click [Export] · [HTML...] in the [File] menu.

CCThe Export HTML dialog box will appear.

(2) Specify the folder where the IPB document will be
saved as a HTML file in the [index file].

CCSelecting [All Pages] will output all the pages of the displayed IPB document to the HTML files.

CCSelecting [Current Page] will output only the page displayed in the main view to the HTML file.

CCSelecting [Pages] will output the specified page or the specified page range to the HTML file. Enter a
comma to separate the page numbers to output the specified pages. In addition, when specifying a page
range, use a hyphen to connect the first page number and the last page number.

(3) If necessary, change the other export settings shown below and click the [OK] button.

[File] group

Page Image: Enter the width and height of the image of the exported page in pixel units.
Checking (turning ON) the [Constrain Proportions] check box on the right side
will preserve the ration of the length and height of the page even if the
dimensions of the exported page are changed.

Thumbnail Image: Enter the width and height of the thumbnail image of the exported page in
pixel units. Checking (turning ON) the [Constrain Proportions] check box on
the right side will preserve the ration of the length and height of the page even
if the dimensions of the exported page are changed.

[Colors] group

Background: Select the color of the background of the HTML file.

Text: Select the color of the text used in the HTML file.

Table Labels: Select the background color of the labels of the tables in the HTML file.

Table Items: Select the background color of the items of the tables in the HTML file.
CClicking the rectangular colored portion will display the Color dialog box. Click

the color from the Basic colors.

Remark:
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[Export Contents] group

Thumbnail Image: Turn this check box ON to add a thumbnail image of the page to the index page
of the exported HTML file.

Page Date: Turn this check box ON to display the date and time the page was created on
the index page of the exported HTML file.

Created Date: Turn this check box ON to display the date and time the IPB document was
created on the index page of the exported HTML file.

Modified Date: Turn this check box ON to display the date and time of the last update done to
the IPB document on the index page of the exported HTML file.

Participants: Turn this check box ON to display the participants of the meeting information set
in [Information...] in the [Settings] menu on the index page of the exported HTML
file.

Manager: Turn this check box ON to display the manager of the meeting information set in
[Information...] in the [Settings] menu on the index page of the exported HTML
file.

Subject: Turn this check box ON to display the subject of the meeting information set in
[Information...] in the [Settings] menu on the index page of the exported HTML
file.

Description: Turn this check box ON to display the description of the meeting information set
in [Information...] in the [Settings] menu on the index page of the exported HTML
file.

Contacts: Turn this check box ON to display the contacts of the meeting information set in
[Information...] in the [Settings] menu on the index page of the exported HTML
file.

Company: Turn this check box ON to display the company name of the meeting information
set in [Information...] in the [Settings] menu on the index page of the exported
HTML file.

CWhen exporting multiple pages to HTML files, an index file "index.html" and HTML files named after the
page numbers (for example, n pages) "page_01.html, page_02.html, page_03.html, --- page_0n.html" are
created. Images displayed in the HTML files named after the page numbers "page_01.jpg, page_02.jpg,
page_03.jpg, --- page_0n.jpg" are also created.
If the Thumbnail Image check box is turned ON, thumbnail images displayed in the HTML files named after
the page numbers "small_01.jpg, small_02.jpg, small_03.jpg, --- small_0n.jpg" are also created.

CWe recommend saving HTML files in folders where HTML files exported from other IPB documents are not
stored. If you attempt to save a file in an already existing folder, a message will be displayed asking you to
confirm whether or not to overwrite the already existing HTML file.

Note

Remark:
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View Window or Whiteboard Window Operation

(1) Position the cursor over [Zoom] in the [View] menu and click the percentage (%) you want
to display.

■ Change display method

CCDisplay expanded/reduced page
You can expand the page and display a portion of the page larger or reduce the page and display the entire
page.

(1) Click [Fit Window] in the [View] menu.

CCDisplay page at the same size of the main view

(1) Click [Full Screen] in the [View] menu.

CCTo exit full screen display mode and return to the original display mode, right-click the mouse and
click [Full Screen] in the pop-up menu.

CYou can also enter a numeric value into (Zoom) to change the display percentage. The percentage
can be set in units of 1%.

CCDisplay page as large as possible
To display the page on the screen as large as possible, switch to full screen display mode.
In this mode the toolbar is displayed as a free toolbar.

CTo turn OFF the Toolbar in full screen display, right-click the mouse and click the Toolbar you want to turn
OFF in the pop-up menu and remove the check mark.
In addition, to display the Toolbar, click the Toolbar you want to display in the pop-up menu and add the
check mark.

Remark:

Remark:
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(1) Click [Go to Previous Page] in the [Page/Play] menu.

■ Switch a page of the IPB document

CCDisplay previous page

(1) Click [Go to First Page] in the [Page/Play] menu.

CCDisplay first page

(1) Click [Go to Next Page] in the [Page/Play] menu.

CCDisplay next page

(1) Click [Go to Last Page] in the [Page/Play] menu.

CCDisplay last page

(1) Click [Go to Page...] in the [Page/Play] menu.

CCThe Go to Page dialog box will appear.

(2) Enter the page number you want to display in [Go to Page:].

(3) Click the [OK] button.

CCSpecify a page number to display

CTo quickly display a page, click the thumbnail display of the page you want to display in thumbnail view.

■ Edit a page of the IPB document
You can edit pages displayed in the main view in the View window or Whiteboard windows as follows.

CYou can use the marker or eraser for additions and modifications.
CYou can add a page. (Whiteboard window only)
CYou can delete a page.
CYou can select portions or entire page and save the contents in the clipboard or copy to other applications.

(1) Display the page where you want to draw or erase handwritten lines in main view.

(2) To draw handwritten lines, click either (Black Marker, Red Marker, Blue Marker or
Green Marker) in the [Markers/Eraser] Toolbar.

CCThe shape of the mouse cursor changes to .

(3) Position the mouse where you want to draw a handwritten line on the page and drag the
mouse.

CDraw and erase handwritten lines on a page

Remark:
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View Window or Whiteboard Window Operation

(4) To erase handwritten lines, click (Eraser) in the [Markers/Eraser] Toolbar.

CCThe shape of the mouse cursor changes to .

(5) Drag the mouse to the area on the page you want to erase.

CTo return to the state before the changes, click [Undo] in the [Edit] menu.
CThe width and color of the markers and the size of the eraser can be changed.

(1) Click [Undo] in the [Edit] menu.

CCTo return to the previous state, click [Undo] again.

CCUndo
You can return handwritten lines drawn using the marker or erased using the eraser to their original state,
stroke by stroke.

CTo perform the operation that was undone once again, click [Redo] in the [Edit] menu.
CThe [Undo] / [Redo] can be used over and over however if the page changes, the [Undo] / [Redo] may reset.

CA maximum of 50 pages can be recorded. This software cannot add more than 50 pages.

(1) Click [Add New Page] in the [Edit] menu.

CCA new page will be added next to the last page of the IPB document and the display switched to that
page.

CCAdd a new page to the IPB document (Whiteboard window only)
In the Whiteboard mode, add a new page next to the last page of the IPB document.
When advancing the screen of the Interactive Panaboard during a meeting, add a new page.

(1) Click [Add Copy Page] in the [Edit] menu.

CCA copy of the currently displayed page will be added next to the last page of the IPB document
and the display switched to that page.

CCAdd a copy of the currently displayed page to the IPB document (Whiteboard window
only)
In the Whiteboard mode, add a copy of the page currently displayed in main view next to the last page of the
IPB document.
Use this to leave the current contents on the screen of the Interactive Panaboard unchanged while adding new
changes.

CA maximum of 50 pages can be recorded. This software cannot add more than 50 pages.

Remark:

Remark:

Remark:

Remark:

Download from Www.Somanuals.com. All Manuals Search And Download.



56

View Window or Whiteboard Window Operation

(1) Display the page you want to delete in the main view.

(2) Click [Delete Current Page] in the [Edit] menu.

CCA dialog box will be displayed asking you to confirm the delete.

(3) Click the [OK] button to delete.

CCDelete currently displayed page

(1) Click (Arrow) in the [Markers/Eraser] Toolbar.

(2) Diagonally drag the mouse over the portion of the page you want to select.

CCThe selected area will be displayed in reverse.

CCTo select the entire page, click [Select All] in the [Edit] menu.
The entire page will be displayed in reverse.

CCSelect page

(1) Click (Arrow) in the [Markers/Eraser] Toolbar and drag the mouse to select the portion
of the page you want to copy.
In addition, to select the entire page, click [Select All] in the [Edit] menu.

CCThe selected area will be displayed in reverse.

(2) Click [Copy] in the [Edit] menu.

CCCopy selected page range to clipboard

CUse caution because deleted pages cannot be recovered to their original state by [Undo] in the [Edit] menu.

CTo cancel the selected state, click outside of the selected area.

Note

CTo cancel the selected state, click outside of the selected area.
CThe Image copied to the clipboard can be pasted in other applications.
CThe Image copied to the clipboard becomes BMP image.

Remark:

Remark:
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(1) Open the file where the data will be copied to and adjust the position of the application
window such that the page to be copied and the file to be copied to are displayed in the
screen. Arrange the documents such that both the information to be dragged and the
position where that information will be dropped are displayed.

(2) Click (Arrow) in the [Markers/Eraser] Toolbar and drag the mouse to select the portion
of the page you want to copy.
In addition, to select the entire page, click [Select All] in the [Edit] menu.

CCThe selected area will be displayed in reverse.

(3) Drag the selected area to the copy destination of the other application.

CCCopy selected page range to other application by dragging and dropping
You can copy data to other applications by dragging and dropping the selected page area. To perform this
operation, the application copied to must support OLE (Object Linking and Embedding).

CTo cancel the selected state, click outside of the selected area.
CThe file formats when copying by dragging and dropping can be selected from the formats below.

Bitmap Files (*.bmp), TIFF Files (*.tif) or JPEG Files (*.jpg)

■ Playback the IPB document
The operations of drawing and erasing handwritten lines on each page are automatically recorded in stroke units
and the locations of the drawing can be played back and confirmed later.

1 Click (Start) in the [Page/Play] Toolbar.

CThe Play Scroll bar in the [Page/Play] Toolbar will move
to the left end to return the page contents to their original state, and then the playback will start.

CTo stop the playback in the middle, click (Pause) in the [Page/Play] Toolbar. To restart 

the playback in the middle, click (Start) in the [Page/Play] Toolbar.
CWhile stopping temporarily, you can move the Play Scroll bar in the [Page/Play] Toolbar to

playback manually.
CTo end the playback in the middle, click (Stop) in the [Page/Play] Toolbar.

2 When the Scroll bar moves to the right end, the playback will end.

CYou can click the arrows at the right and left of the Play Scroll bar or drag the Play Scroll bar to the right or left to
playback the drawing.

CWhile playing back, you cannot use the marker and eraser in the [Markers/Eraser] Toolbar. In addition, in
Whiteboard mode drawing on the screen of the Interactive Panaboard will not be reproduced either.

CYou can adjust the playback interval. (See page 59.)

Remark:

Remark:
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(1) Click [Print Preview] in the [File] menu.

CCSwitch to the Print Preview screen.

(2) Click the [Close] button to exit the Print Preview and return the display mode to the
original state.

■ Print the IPB document

CCConfirm print image of the IPB document before printing

CThe screen display mode that displays an image of the file when it is printed is called the Print Preview. In the
Print Preview you can display print images of multiple page at a time. You can also expand or reduce the size
of the page displayed in the screen.

(1) Click [Print] in the [File] menu.

CCThe Print dialog box will appear.

(2) Set the [Printer], [Print range] and [Number of copies].

(3) Click the [OK] button.

CCThe Printing dialog box will appear.
CCTo stop the printing, click the [Cancel] button in the Printing dialog box.

(1) Click [Information...] in the [Settings]
menu.

CCThe Information dialog box will appear.

(2) Enter necessary information as follows, and then click the [OK] button.

CCPrint currently displayed IPB document

■ Settings

CCSetting meeting information
Set meeting information recorded in the IPB
document. Information that can be saved includes
titles, subjects and descriptions, participants and
related contact information.
Setting the information of a meeting will also allow
you to output page images when exporting the IPB
documents to HTML files.

Remark:
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[Summary] Enter a summary of the recorded meeting here.

Title: Enter the title of the meeting.

Participants: Enter the participants of the meeting.

Company: Enter the name of the company.

Manager: Enter the individuals responsible for the contents of the meeting.

Create On: Automatically displays the date and time the IPB document was created.

Modified On: Automatically displays the date and time the IPB document was updated finally.

Subject: Enter the subject of the meeting.

Description: Enter a description of the contents of the meeting.

[Contacts] Enter information to contract individuals for questions concerning the meeting here.

Name: Enter the names of the person in charge of the meeting.

e-mail: Enter the e-mail address of the person in charge of the meeting.

Home page: Enter the home page of the person in charge of the meeting.

(1) Click [Play...] in the [Settings] menu.

CCThe Playback Setting dialog box will appear.

(2) Enter an interval for playing back the stroke in the Interval time
between strokes.
You can click the arrows at the right and left of the scroll bar or
drag the scroll bar to the right or left to set a desired interval.

CCSet the interval when playing back the IPB document

CThe playback interval can be set in a range of 0 - 2 seconds in 1 msec (millisecond = 1/1000 second) units.

(1) Click [Markers and Eraser...] in the [Settings] menu.

CCThe Marker/Eraser Setting dialog box will appear.

CCSet the marker width, color or the eraser size
Change the width and color of the markers and the size of the eraser used in the View window or the
Whiteboard window.
The marker width and color can be changed for four marker colors.

Remark:
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(2) To change the width of the markers, either enter a width in (Marker Width) at the
right side of the marker whose width will be changed or click the up/down arrows on the
right side to set a desired width.

To change the color of the markers, click (Marker Color) on the right side of the
marker whose color will be changed. The Color dialog box will appear. Click the color you
want to change from among Basic colors, and click the [OK] button.

To change the size of the eraser, either enter a size in (Eraser Radius) or click
the up/down arrows on the right side to set a desired size.

(3) Click the [OK] button.

(4) A dialog box will appear where you can select whether or not to apply the new settings to
handwritten lines drawn up to now.
Clicking [Yes] button will redraw the lines drawn up to that point using the new settings.
Clicking [No] button will only reflect the new settings for any subsequently drawn lines.

CThe unit of the maker width and the eraser size is dots in the View window and millimeters or inches in the
Whiteboard window.

CThe marker width can be set in a range of 1 - 30 dots in the View window and 0.1 - 25.4 mm (0.01 - 1 inch) in
the Whiteboard window.

CEven though the marker colors are changed, the colors of the marker buttons in the [Markers/Eraser] Toolbar
and the mouse cursor will not change.

CThe eraser radius can be set in a range of 1 - 60 dots in the View window and 0.1 - 50.8 mm (0.01 - 2 inch) in
the Whiteboard window.

CThese settings are effective until being changed.

(1) Click [Export Image...] in the [Settings] menu.

CCThe Export Image Settings dialog box will appear.

CCSet an image file when exporting or copying by dragging and dropping
Set the size when exporting a page to an image file and the file
format to create when copying data to other applications by
dragging and dropping a selected page area.

Remark:
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View Window or Whiteboard Window Operation

(2) The following items can be set.

(3) Click the [OK] button.

[Export Image Files] group

Image Size: To change the size when saving a page as an image file, enter a desired width and
height.
Check (turn ON) the [Constrain Proportions] check box when setting the aspect ratio of
the page to an identical value even if the page dimensions change while saving it as
the image file.

JPEG: To set the quality level when exporting a page as a JPEG format image file.

TIFF: To perform compression when exporting a page as a TIFF format image file, check
(turn ON) the [Compression (PACKBITS)] check box.

[Drag and Drop Files] group

Set the file format to create when copying data to other applications by dragging and dropping a
selected page area.
The following file formats can be selected.

WindowsBMP (*.bmp), JPEG (*.jpg) or TIFF (*.tif)
If JPEG is selected, you can enter a quality level in [Quality:].

If TIFF is selected, you can set Compression/No-compression using the [Compression
(PACKBITS)] check box. Turn the check box ON for compression.

CThe default of the width is 800 dots and the [Constrain Proportions] check box is checked (ON). The height
will be different depending on the size of the Panaboard screen and the screen resolution of the PC where
the projector is projecting the image.

(1) Click [File...] in the [Settings] menu.

CCThe File Settings dialog box will appear.

(2) The following items can be set.

CCSet a work folder and the recovery file
Set the default folder when saving an IPB document.
In addition, if settings are made to automatically create a recovery
file, previously saved IPB documents can be recovered if a power
failure or other incident occurs.

(3) Click the [OK] button.

Save Default Folder: Set the path of the folder
you want to display as a
default when saving a new
IPB document.

Create Recovery File: To create a recovery file, add a check mark (turn ON).

Recovery File Folder: To save the recovery file at the same folder as the original file, add a
check mark (turn ON) to the [Same folder as original file] check box.
Otherwise, set the directory to save the recovery file.

Save automatically every x minutes:To set the automatic save interval of the recovery file in a range of 
1 - 120 minutes.

Remark:
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(1) Click [Options...] in the [Settings] menu.

CCThe Options dialog box will appear.

(2) The following items can be set.

Display full path in Title bar: To display the full path of the currently opened file in the title bar of the View
window or the Whiteboard window, add a check mark (turn ON).

Measurement: To switch the display unit system of the Whiteboard window.

(3) Click the [OK] button.

View Window or Whiteboard Window Operation

CCOption setting
Set the display method of the file name in the Title bar and the display unit system.

CThe computer screen will be projected onto the screen of the Interactive Panaboard in the Projector mode
and because there is no physical size, the display unit system is only in pixels (dots) and cannot be changed.

CThe display unit systems of millimeters / inches are used as units to represent the page size on the status
bar, pen width and eraser size.

Remark:
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Remote Conferencing using Microsoft® NetMeeting®

■ About NetMeeting®

■ Example of using NetMeeting®

Microsoft® NetMeeting® is a software to share information with the computer connected in the network. When the
Interactive Panaboard is connected with the computer connected in the network and NetMeeting® is used, it is
possible to confer on the remote place using the Projector mode or the Whiteboard mode of the Interactive
Panaboard Software.
It is necessary to install NetMeeting® in each computer which confers on the remote place. We recommend using
NetMeeting® 3.0 or later. You are able to download latest NetMeeting® from the Microsoft® Corporation
NetMeeting® Home Page of the Internet. (http://www.microsoft.com/windows/NetMeeting/)

This section explains an example of the remote conferencing using NetMeeting®.
For detailed explanation concerning NetMeeting®, please refer to help of NetMeeting® or the Microsoft®

Corporation NetMeeting® Home Page of the Internet.

5 Share a program of the computer which sponsors the remote conferencing.

CWhen you use the program sharing feature, other people can see the program.

CWhen the Projector mode is used, share the Desktop.

CWhen the Whiteboard mode is used, share the Whiteboard window of the Interactive Panaboard
Software.

CWhen you allow control, other people can both see and use the program.
It is only one person at a time to be able to control the shared program.

2 Run NetMeeting® with all computers which confer on the remote place.

Connect the Interactive Panaboard with the computer which sponsors the remote
conferencing, and run the Interactive Panaboard Software with the Projector mode or the
Whiteboard mode.

1

3 Call the computer which participates from the computer which sponsors the remote
conferencing.

CTo call, select from the user who connects the computer with the Internet directory server or input
IP address directly.

4 Receive the call with the computer which participates in the remote conferencing.

6 Confer on the remote place using the shared program.

7 When the remote conferencing finishes, stop sharing a program and exit NetMeeting®.
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Remote Conferencing using Microsoft® NetMeeting®

CYou cannot call people on the Internet that you have located on Wed-based directory servers if your Internet
connection uses a proxy server that does not support NetMeeting®.

CWhen you share a program and decide to allow someone to control it, remote users can use the File Open
and File Save dialog boxes in your program to gain access to or delete files on your computer or network.
It is recommended that you do not leave your computer unattended while sharing a program and allowing
control.

CYou can connect to only one other person with audio and/or video at a time.

Note
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Cleaning the screen and the unit
Gently wipe the screen film and unit with a water-dampened
cloth that has been thoroughly wrung.

Use a commercially available white board cleaner for 
hard-to-clean stains. (SANFORD® EXPO® white board
cleaner etc.)
If you accidently write on the board with an oil-based
marker, wipe with a small amount of ethyl alcohol.

Daily Care and Maintenance
Always turn off the power switch and unplug the power plug when cleaning outside and inside the unit.

CDo not use thinner, benzine or cleaners containing
abrasives as this may result in discoloration.

CDo not wipe the screen film with a dry cloth as this
may generate a static charge.

Note

Printer Door

Printer 
Open Lever

1 Push down the printer open lever and open the
printer door.

Caring for the eraser
When the erasing surface of the eraser becomes dirty, hold
down the sheet under the top sheet with your finger and peel
off the dirty sheet by pulling in the direction of the arrow.

CWhen the eraser becomes thin, make sure that the
corners of the eraser do not strike the screen during
erasing as this may damage the screen.

Note

Cleaning the printer head, platen roller and feed roller
BIf black streaks appear on the copy, clean the printer head and the platen roller.
BIf paper jams occur frequently, clean the feed roller.
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Daily Care and Maintenance

Clean the Printer Head

Printer Head
(Gold)

Cotton Swab2 Dampen the tip of a cotton swab in ethyl
alcohol and gently wipe the printer head.

CNever touch the printer head or the surrounding
area with your hands as this may disable
copying.

Note

Clean the Platen Roller and the Feed Roller

Feed Roller

Platen
Roller

Printer Door

3 Remove the film cassette with both hands and
carefully wipe any dirt or stains off the platen
roller and feed roller.

CFor details on removing the film cassette, see
page 20.

CDampen a soft cloth with neutral kitchen
cleaner diluted in water, wring the cloth
thoroughly, and wipe the entire surface of the
rollers while rotating them. If this does not
remove all dirt, wipe with a cloth dampened
with ethyl alcohol.

Printer Door

4 Attach the film cassette in its original position
and close the printer door.

CFor details on attaching the film cassette, see
page 14.

CClose the printer door firmly until a click is
heard.

CIf  " " is displayed on the multi-copy/error
indicator when the power is turned on, this
indicates that the film cassette has not been
installed properly or that there is slack in the
thermal transfer film. Check the condition of the
film cassette and for slack in the thermal
transfer film.

Note
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Daily Care and Maintenance

Treat problems according to the information given in the table below. If problems still persist, call your dealer for service.

Replacing the Batteries in the Electronic Pen and the Electronic Eraser
As the lifetime of the batteries in the Electronic Pen or the Electronic Eraser comes near to the
end, the message “Low Battery” appears on the PC screen to which the electronic print board is
connected using interactive functions. When this message appears, get new batteries ready and
replace the old ones as soon as possible.
When replacing batteries, remove the old batteries and replace according to step 1 under “Setting
the Electronic Pen” on page 24 in the case of the Electronic Pen or according to “Setting the
Electronic Eraser” on page 25 in the case of the Electronic Eraser. Continued use of low batteries
may result in a shifting of position or malfunction.

Replacing the Cloth of the Electronic Eraser
If the cloth of the Electronic Eraser becomes dirty with erased markings, replace with a new eraser
cloth according to “Replacing the eraser cloth” on page 25.

Symptom See
PageCare and Remedy 

Power switch is on but the
indicator is off.

Check that the power plug is securely plugged in.
(If the indicator still does not light, turn the power off and on again.)

16
20

Copied copy paper will not
come out.

The unit is out of copy paper or thermal transfer film. (Error indicator flashes " " or " ".)

Insert copy paper or replace the thermal transfer film.

The printer door is open. (Error indicator flashes " ".)

Close the printer door firmly until a click is heard.

Paper is jammed in the printer. (Error indicator flashes " ".)

Open the printer door and remove the jammed paper.

The platen roller and feed roller are dirty.

Open the printer door and clean the platen roller and the feed roller.

15

21

65

Nothing is printed on the
paper or copies are faint or
blurred.

BThe writing on the screen is too thin or light. 

Make thicker, darker lines or change to a new marker.

BThe markers for interactive (Small) are used. 

Use the markers (Big).

The printer door is slightly open. 

Close the printer door firmly until a click is heard.
15

Black streaks or blank
(unprinted) spots appear
on the copy (copy paper is
dirty).

The printer head or platen roller is dirty.

Open the printer door and clean any dirt off the printer head and platen roller.

The room temperature is 10°C (50°F) or lower. 

Increase the room temperature, turn the unit's power off and on, and  retry copying.

The thermal transfer film is wrinkled because it was set in place without removing
excess slack. 

Rewind the used portion of the thermal transfer film to remove the excess
slack, then reattach it.

65

15
21

Troubleshooting
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Troubleshooting

The screen does not
advance when the COPY
or ADVANCE keys are
pressed. 

Static electricity was generated when the screen film was wiped.

Turn off the power and slowly move the screen by hand.

Contrast/Remaining 
film indicator flashes.

The time to replace the thermal transfer film is approaching. (Only about 15 more
copies can be made.) 

Prepare a new replacement film (KX-BP081 or KX-BP082).

Data written on the
electronic print board may
disappear from the
electronic print board
screen and the computer
screen or its position may
shift when the interactive
function is used.

Unnecessary streaks not
written are displayed on the
computer screen when the
interactive function is used.

The message “Low
Battery” appears on the
computer screen.

BUse the Electronic Pen inclined at an angle.
BDirect sunlight or strong light is striking the screen.
BA remote controller is being aimed at the receiver on the electronic print board.
BThe side of the electronic print board is placed near the wall, or the top of the

electronic print board is placed near the ceiling.
BThe electronic print board is placed near the vents of an air conditioner.
BThe receiver of the electronic print board is blocked by a hand or other object.
BThe transmitter of the Electronic Pen or the Electronic Eraser is covered with your

hand.
BTwo or more the Electronic Pens or the Electronic Eraser are used at the same time.
BIf the position shifts for reasons other than the above, adjust the position according

to "Adjustment" on page 31.

Do not do the followings near the electronic print board while using the interactive
function.
BExchanging markers for interactive (Small) of the Electronic Pen
BSetting or removing a marker cap of the Electronic Pen
BPushing the point of the Electronic Pen

Replace batteries of the Electronic Pen or the Electronic Eraser which have “Low
Battery” message displayed.

The Electronic Pen position
may shift when the
Projector mode is used.

The projection position shifts.
Calibrate to reposition the projected image on the screen.

Detection of the marker
color of the Electronic Pen
does not work well when
the Whiteboard mode of
the interactive function is
used.

The marker for interactive (Small) is not securely set.
Rotate the pen holder lever to the release potion, and then return the pen
holder lever to the lock position while inserting the marker until you hear a
buzzing sound.

The proprietary marker for interactive (Small) is not set into the pen holder.
Use the proprietary markers for interactive (Small).

The computer can not
recognize the electronic
print board when the
interactive function is used.

Communication port setting is not appropriate.

Change communication port setting according to “COM port” on page 30.

Check that the interactive cable is securely connected.

Symptom See
PageCare and Remedy 

20

30

67

33

24

71

26
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Troubleshooting

■ Meanings of various displays
The following table describes the meaning of each of the symbols which may flash in the Multi-Copy/Error indicator.

Indication See
PageCause Remedy

Out of paper.

The printer door is not closed securely.

The thermal transfer film is slack or has run
out.

Paper jam.

The screen will not move.

The room temperature is 10°C (50°F) or lower.

Load copy paper.

Close the printer door securely.

Remove the slack from the thermal transfer film
or replace.

Open the printer door and remove the jammed
paper.

Remove any chart paper attached to the screen
and slowly move the screen by hand.
Increase the room temperature.

16

15

15
20

21

The fluorescent lamp is dead. Call your dealer for service.

BIf other indications such as " " appear, call your dealer.
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Specifications
Model Number KX-BP800

Power Supply AC100 -120 V, 50/60 Hz

G
en

er
al

Power Consumption
(Operational/Standby)

2.2 A/ 0.1 A

External Dimensions
Height✕Width✕

Depth

1,400✕1,550✕240 mm (4' 71/8"✕5' 11/32"✕97/16")

Screen Size 1,651 mm (65") Diagonal

Weight (without stand) 34.0 kg (75 Ibs)

Ambient Operating Conditions

Writing Implements
Dry erase felt-tipped markers (black, red, blue and green*)

The green marker is only for the interactive function.

1,875✕1,550✕1,100 mm (6' 113/16"✕5' 11/32"✕3' 75/16")

Without stand

With stand

In
p

u
t

B
lo

ck Panel Surfaces 2 (endless type)

Panel Advance System Scroll type

Copying Area
Height✕Width

850✕1,330 mm (2' 915/32"✕4' 43/8")

Scanning System CCD flat-scan type

Printing System Fusion thermal transfer type

O
u

tp
u

t
B

lo
ck

Copy Paper Standard or recycled paper [60 - 90g/ m2 (16-24 lbs)]

Copy Paper Size Letter [216✕279.4 mm (81/2"✕11")]

Copy Density 8dots/ mm (203 dots/inch)

Copy Color Black

Contrast Adjustment Two levels: Normal/Dark

2-Screen Compressed Copying Yes

Time Required for Copying 15 sec. /sheet

Continuous Copies 1 to 9 sheets

Out-of-Paper Indication Yes

Effective Area
Height✕Width

Projector mode: 850✕1,330 mm (2' 915/32"✕4' 43/8")
The position cannot be detected within 50 mm (2") of the upper screen border.

Whiteboard mode: 825✕1,330 mm (2' 815/32"✕4' 43/8")
The whiteboard cannot not be written on within 50 mm (2") of the upper screen border and 25 mm

(1") of the lower screen border.

It is not always possible to normally detect the position within 100 mm (315/16")
of the position receiver and 35 mm (13/8") from the both sides of the screen.

In
te

ra
ct

iv
e

Fu
nc

tio
n

Interface RS-232-C

Battery for Electronic Pen or
Electronic Eraser

LR03 (“AAA” size) ✕2
Alkaline battery

Battery Longevity for Electronic
Pen or Electronic Eraser

Interactive Function
Temperature : 15 - 30°C (59 - 86°F), Humidity : 30 - 80% R.H.

Other than Interactive Function
Temperature : 10 - 35°C (50 - 95°F), Humidity : 30 - 80% R.H.
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Specifications

Wall-mounting Kit KX-B063

Stand KX-BP065

fo
r

P
ri

n
t

B
o

ar
d

PC Interface Kit KX-BP095 (for connection to PC)

Replacement Film
KX-BP081 [contains two 100m (328.1') rolls]
KX-BP082 [contains 100m (328.1') roll and film cassette]

Markers (Big) and Eraser Set
KX-B035 (contains one black, one red, one blue marker, 

and one eraser)

KX-BP0385 (contains one black, one red, one blue and 
one green marker)

Pen Holder KX-BP038

KX-BP048

fo
r

In
te

ra
ct

iv
e

Electronic Eraser

Marker (Small) set

KX-BP0481 (set of 10 cloths)Eraser Cloth (for Electronic Eraser)

■ Consumable and accessories

Ruler kit (KX-B05) can not be used with the interactive function.

CThe markers (Big) and the eraser are used for other than the interactive function.

CThe markers for interactive (Small) are used while inserted in the pen holder.
The Electronic Pen [a marker for interactive (Small) inserted in the pen holder] and the Electronic Eraser are used
with the interactive function.\

CPC Interface (Option)
When the optional PC Interface Kit (KX-BP095) is used, you can scan monochrome images from the KX-BP800 into
a computer running Microsoft® Windows® or Windows NT® and print documents on the computer to the printer of the
KX-BP800.
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Installation Manual
(for qualified service personnel)

Assembling the Print Board  . . . . . . . . . . . 73
CAssembly  . . . . . . . . . . . . . . . . . . . . . . . 73

Print Board Operations Check  . . . . . . . . . 76
CNormal print board operations check  . . . . . 76

CInteractive operations check  . . . . . . . . . . . 77

Repacking  . . . . . . . . . . . . . . . . . . . . . . . . 77

Pages

Assembling the Optional Stand (KX-BP065)  . . . . . 78
CAccessories  . . . . . . . . . . . . . . . . . . . . . 78

CAssembly  . . . . . . . . . . . . . . . . . . . . . . . 79

Wall-mounting Kit (KX-B063)  . . . . . . . . . . 81
CAccessories  . . . . . . . . . . . . . . . . . . . . . 81

CWall-mounting procedure . . . . . . . . . . . . . 82

CAttaching the wall-mounting fixtures  . . . . . . 83

Pages

Table of contents

Before installing this set, please read this manual completely.
For instructions on installing the software, please see page 27.

WARNING
DO NOT INSTALL THIS OPTION EXCEPT QUALIFIED SERVICE PERSONNEL.

CAUTION
SAFETY CHECK MUST BE DONE BY QUALIFIED SERVICE PERSONNEL
AFTER INSTALLING THIS OPTION.

Accessories
The following accessories are required for assembly.

Part name Part illustration/quantity Attachment procedure

Power cord Page 75, Item 4.1

Wall mounting template

(for wall mounting)
Page 82, Item 2✕1

✕1

All accessories included in the package are given on the next page. 
Make sure that all of these parts are included in the package before proceeding.
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Assembling the Print Board
■ Assembly

• Film cassette . . . . . . . . . . . . . . . . . . . . . . . . . 1
• Blue gear . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
• Green gears . . . . . . . . . . . . . . . . . . . . . . . . . .  3
• Thermal transfer film [20m (65.6')] . . . . . . .  1

• Markers (Black, Red, Blue-Big) . . . . . . .Each 1
• Eraser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1
• Letter papers . . . . . . . . . . . . . . . . . . . 20 sheets
• Pen holder . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
• Markers  for interactive 

(Black, Red, Blue, Green-Small) . . . . . .Each 1
• Electronic eraser . . . . . . . . . . . . . . . . . . . . . . .1
• Eraser cloth (for electronic eraser) . . . . . . . . .2
• Batteries (LR03 "AAA") . . . . . . . . . . . . . . . . . .6
• Power cord . . . . . . . . . . . . . . . . . . . . . . . . . . .1
• Interactive cable (5m) . . . . . . . . . . . . . . . . . . .1
• Software CD-ROM . . . . . . . . . . . . . . . . . . . . . .1
• Operating Instructions . . . . . . . . . . . . . . . . . . .1
• Software License Agreement . . . . . . . . . . . . . .1
• Wall-mounting template. . . . . . . . . . . . . . . . . .1
• Warranty card . . . . . . . . . . . . . . . . . . . . . . . . .1

1 Assembly of the optional stand or wall-mounting kit. 

■ If you are using a stand, refer to page 78.

■ If you are using a wall-mounting kit, refer to page 81.

2 Remove the print board from the shipping box. 

Remove the joints, then remove the print board from the shipping box.

CDo not touch the screen film surface as doing so may damage it.
CThe shipping box, cushioning material, and other packaging materials will be necessary if

you ever need to repackage the print board, so do not throw them away.

Note
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Assembling the Print Board

3 Attach the print board. 

■ If you are using a stand: 
1. Hang the print board on the

attachment fixtures of the stand.

2. Use the two wing bolts (M5 
12 mm) provided with the stand
to fasten the print board to the
lower stand attachment fixtures
as shown below.

■ If you are using a wall-
mounting kit:

1. Remove the two wing bolts and
hang the print board on the wall-
mounting fixtures supplied with
the wall-mounting kit.
(Please refer to page 82.)

2. Use the two wing bolts removed in
step 1 above to fasten the print
board to the lower wall-mounting
fixtures as shown below.

CWhen mounting the print board, avoid banging it.
Such impact may break the internal fluorescent
light or cause other damage.

CAfter mounting the print board, gradually apply
weight to it to make sure that the wall is strong
enough to support it.

�L

�R

�L

�R

1

2

CThe stand (KX-BP065) is available as an option. CThe wall-mounting kit (KX-B063) is available as an
option.

Note
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Assembling the Print Board

4 Attach the power cord. 

1. Securely fit the supplied power
cord into the AC inlet on the
printer unit.

2. Fit the power cord into the cord
holder. Do not force it.

CDo not use thinner, benzine or cleaners
containing abrasives as this may result in
discoloration.

CDo not wipe the screen film with a dry
cloth as this may generate a static
charge.

5 Wipe the screen film surface. 

Wipe the screen film gently with a
water-dampened cloth that has
been thoroughly wrung.

6 Check operations.  

Refer to page 76 "Print Board
Operations Check".

Power Cord

AC Inlet

Cord Holder

Note

Download from Www.Somanuals.com. All Manuals Search And Download.



76

Print Board Operations Check
After assembling the print board, perform the procedures presented in the following table to make sure it functions
properly.

■ Normal print board operations check

Step
Normal print board operations (points to check)

Multiple copy/
error display Other points to check

1 Turn on the power switch. " " flashes after
" " lights up.

2 Open the printer door and attach the supplied
thermal transfer film, then close the printer door.
CInstalling Thermal Transfer Film procedure 

(refer to page 14)

" " flashes.

3 Open the paper cover and insert ordinary Letter
test paper, then close the paper cover.
CLoading Copy Paper procedure 

(refer to page 16)

" " lights up.

4 Open the printer door. " " flashes.

5 Close the printer door. " " lights up.

6 Press . CDoes the screen film surface
feed smoothly?

CAre there any strange noises?

7 Use the supplied marker to draw a large 

filling the entire copyable area of the 

screen film surface.
CCopyable area (refer to page 9)

Press twice. (will add to 3 copies)

C" " will be displayed.

Press .

" " lights up.

CAre three copies made?
CIs the entire readable area

printed?
CDuring the copying process, are

there any strange noises or
paper jams? Are multiple sheets
of paper fed through at the same
time?

8 Press to move the screen film surface. 

Write letters, etc. with the marker.

Press once.

Press  .

CHas the darkness indicator light
turned on?

CIs the image copied properly?
CAre there strange markings on

the copy sheet (e.g., stripes or
lines)?

9 Press once. Has the darkness indicator light
turned off?

10 Press .1 2 Are two screens copied properly?

BIf the unit fails on any of the check points, please contact your dealer.
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Print Board Operations Check

■ Interactive operations check

1 Connect the print board to the PC according to the instructions of page 26 using the
supplied interactive cable.

2 Install the software on the PC according to the instructions of page 27 and check that
the interactive function operates.

If the Electronic Pen position shifts, adjust the position according to the instructions of page 31.

Joint

Shipping Box

Perform assembly steps 2 through 4 (refer to pages 73 through 75) in reverse to repack
the print board and accessories. Use the joints to fasten the shipping box to the upper and
lower box.

CRefer to the shipping box instructions
for information on how to fasten the
16 joints.

Repacking

Download from Www.Somanuals.com. All Manuals Search And Download.



78

Assembling the Optional Stand (KX-BP065)

■ Accessories
The package box for the optional stand includes the parts noted below; please confirm that all parts are present
before beginning installation.

No. Part name Part illustration Q'ty No. Part name Part illustration Q'ty

Stand base 2

Pipe 2

Cover 2

Side bar A 2

Side bar B 1

Screw 12

Fixture

(left)
2

Fixture

(right)
2

Wing bolt 6

Support

bracket
2

Fall-prevention

extension leg
4

Screw 4

Nut 4

Wrench 1

M8✕45mm (125/32")

M5✕12mm (15/32")

M6✕60mm (23/8")

1 The accessory wrench is required when disassembling the electronic print board; please store

it carefully for future use.

CBefore assembly, be sure to lock the casters.

Locking the casters

(Push this side)

Releasing the lock

8

9

10

11

12

13

1
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Assembling the Optional Stand (KX-BP065)

■ Assembly

1 Assembling the stand

13

12
1

11

Assembling the fall-prevention extension legs.
The fall-prevention extension legs increases the safety of the

electronic print board.

Fall-prevention extension legs CCaster locks are attached to

the back side.

Insert the covers to the pipes .

3

2

✽1

✽1

A

Assemble with the 
holes toward the front.

Locking casters side.
(rear)

Locking 
casters side.
(rear)

CTo lock the fall-prevention
   extension legs, lift portion A.

6

3
3

5

2
2

6

6

4

4

10

10

1 Do not tighten the screw too much. This may deform the pipes.
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Assembling the Optional Stand (KX-BP065)

2 Attach the attachment fixtures with the four wing-bolts.8

9

9

9

9

8

8

7

7

3 Assemble and install the print board.

Please refer to assembly instructions on page 74.
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Wall-mounting Kit (KX-B063)

Before attempting installation of this wall-mounting kit, we strongly recommend consulting with the building facility nor
manager, engineer, or architect. The installer needs to know the type of construction used for the wall intended for this
installation and the location of wall studs. Selection of hardware is critical for safe wall-mounting, and dependent upon
the nature of wall construction, installation should not occur until this consultation takes place.

Procedure for KX-B063 Wall-mounting Kit Installation

.Tools required:

One (1) KX-B063 kit
A minimum of eight (8) pieces of appropriate wall-support hardware (molley, toggle, etc.) 
NOTE :THIS HARDWARE MUST BE LOCALLY PROCURED, IT IS NOT INCLUDED IN THE KIT.
Drill (and drill bit of correct size) for hardware installation
Screw driver (Both phillips (+) and slotted (-) will be required.) 
Tape measure
Tape or thumb-tacks (2pcs) 
Bubble type level

.Pre-requisites

1. Before installation, make sure that the wall intended for installation is capable of supporting 
flush-mounted. 
[ KX-BP800 is 103 kgf (227 Ibs). ]

2. The position of the intended installation is of adequate size for the selected Panaboard.
[ KX-BP800 is 1,575 mm X 1,524 mm (5'2"✕5').]

3. An outlet is within 3 m (9'104/32"), and it is not located directly behind the Panaboard.

■ Accessories
The package includes the parts noted below ; please confirm that all parts are present before beginning installation.

Eight screws for mounting the fixtures on the wall are not provided. Please purchase the appropriate wall-mounting
hardware (sold in stores). Refer to pages 83 and 84.

No. Part name Part illustration, Q'ty

L

Order 
of use No. Part name Part illustration, Q'ty Order 

of use

Wall-mounting

fixture L
3

2
Wall-mounting

template

R
Wall-mounting

fixture R
3

Wing bolt

✕2

✕2

✕2

M5✕12 mm (15/32")

No use*

No use*
Use the wall-mounting
template provided with
KX-BP800.

These are used for other models.

✕1

Screw

✕4

M4✕16 mm

No use*
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Wall-mounting Kit (KX-B063)

■ Wall-mounting procedure

1 Confirm that the wall is strong enough to support the weight of the print board.
(Please refer to page 81.)

2 Tape the wall-mounting template to the wall.

BDo not use the template included in the wall-mounting kit (KX-B063), but rather the one included
with the electronic print board (KX-BP800).

BWhen taping the template to the wall, make sure it is level.

Caution:

The wall must be capable of supporting at least

1,005N [ 103 kgf (227 Ibs) ] for KX-BP800.

3 1. Drill holes in the wall for the wall-mounting fixtures. (8 holes total)

2. After removing the wall-mounting template, attach the wall-mounting fixtures with
the appropriate wall-mounting hardware (two screws in each fixture).

This hardware must be locally procured, it is not included in the kit.
BRefer to the section "Attaching the wall-mounting fixtures" (pages 83 and 84) for drilling in the wall and

attaching the mounting fixtures.
Mount the print board. (Please refer to page 74.)

1

5

Wall-mounting
fixture L

Wall-mounting
template (provided with KX-BP800)

Wall-
mounting
hardware*

Wall-mounting
fixture L

Wall-mounting
fixture R

Wall-
mounting
hardware*

812.8mm (2' 8")
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Wall-mounting Kit (KX-B063)

■ Attaching the wall-mounting fixtures
The electronic print board must be mounted with the method most suited to the material of the wall.
Three methods are presented here.
(Other options may be available in your area.)

BAttaching to metal or concrete walls
Stud plugs (sold in stores) are needed.

Drill bit

Metal or concrete
wall

Stud plug

Insert a stud plug in each hole.

Wall-mounting
fixture

Bolt

Drill eight holes in the wall.
For the correct hole size,
refer to the instructions for
the particular stud plugs
used.

Insert each bolt through a
hole in the wall-mounting
fixture and tighten until the
wall-mounting fixture is
securely fixed to the wall.
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BAttaching to plasterboard walls
Split-wing toggles (sold in stores) are needed.

Wall-mounting
fixture

Bolt

Plasterboard

split-wing toggle

Arms

Arms

Insert each bolt through a
hole in the wall-mounting
fixture and into the hole in
the wall beneath so that the
arms of the split-wing
toggle are horizontal. 
For the correct hole size,
refer to the instructions for
the particular split-wing
toggles used.

Tighten each bolt until the
wall-mounting fixture is
securely fixed to the wall.

For the correct hole size,
refer to the instructions for
the particular wood screws
used.

After the arms expand, pull
the wall-mounting fixture
out until the arms of the
split-wing toggle grip firmly
into the wall.

BAttaching to wooden walls
Use wood screws (sold in stores).

Wall-mounting fixture

Wood screw

Wooden wall
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